Xerox® EX Print Server Powered by Fiery® for the Xerox® Color C75 Press / Xerox® Integrated Fiery® Color Server for the Xerox® Color C75 Press

Printing
CONTENTS

INTRODUCTION

Terminology and conventions 8
User software for printing 9

WINDOWS FOR EX PRINT SERVER

Installing Windows printer drivers 10
Installing printer drivers with Point and Print 11
Downloading printer drivers with WebTools 13
Downloading printer drivers from the Fiery server 14
Installing printer drivers from the User Software DVD or downloaded from WebTools 15
Installing the printer driver on a 64-bit Windows computer from a 32-bit Windows Server 2003 computer 17
Installing and connecting to a virtual printer 18
Uninstalling printer drivers 21

Setting up the Windows computer for printing 22
Setting up printing connections 22
Completing the SMB printing connection 22
Completing Standard TCP/IP Port (Raw or LPR) printing connections 23
Completing IPP connections 27
Configuring installable options 29
Configuring and using Job Monitor 30

Printing from Windows computers 31
Setting print options and printing from Windows applications 32
Specifying default print options for print jobs 35
Customizing the Quick Access icon 36
Viewing the color press status 36
Saving files to print at a remote location 36
WINDOWS FOR INTEGRATED FIERY COLOR SERVER

Installing Windows printer drivers
- Installing printer drivers with Point and Print
- Downloading printer drivers with WebTools
- Installing printer drivers from the User Software DVD or downloaded from WebTools
- Installing the printer driver on a 64-bit Windows computer from a 32-bit Windows Server 2003 computer
- Installing and connecting to a virtual printer
- Uninstalling printer drivers

Setting up the Windows computer for printing
- Setting up printing connections
- Completing the SMB printing connection
- Completing Standard TCP/IP Port (Raw or LPR) printing connections
- Completing IPP connections
- Configuring installable options
- Configuring and using Job Monitor

Printing from Windows computers
- Setting print options and printing from Windows applications
- Specifying default print options for print jobs
- Customizing the Quick Access icon
- Viewing the color press status
- Saving files to print at a remote location

MAC OS

Installing Mac OS printer driver files
- Installing printer drivers from the User Software DVD
- Downloading printer drivers with WebTools
- Downloading printer drivers from the Fiery server
- Uninstalling printer driver files
## Setting up Mac OS computers for printing

| Setting up printing with Mac OS X v10.8 | 67 |
| Setting up printing with Mac OS X v10.7 | 71 |
| Setting up printing with Mac OS X v10.6.x | 75 |
| Setting up printing with Mac OS X v10.5.x | 78 |
| Adding a non-English printer on a Mac OS computer | 81 |
| Configuring installable options | 81 |
| Using Desktop Printer (optional) | 81 |

## Printing from Mac OS computers

| Selecting the Fiery server in the Printers list | 83 |
| Setting print options and printing from Mac OS applications | 84 |
| Customizing the Quick Access pane | 87 |
| Viewing the color press status | 87 |

## PRINTING METHODS

### E-mail Service

| Printing using an email client | 88 |
| Managing print jobs with email commands | 91 |

### Printing from a USB flash drive

| Automatic printing | 92 |
| Manual printing | 93 |

### FTP printing

| 94 |

### Printing and retrieving a secure print job

| 95 |

### Sample printing

| Using Sample Print | 96 |
| Customizing the Command WorkStation toolbar | 97 |

### Adobe PDF Print Engine (APPE)

| Printing with the APPE workflow | 98 |
| Printing multiple files with APPE | 99 |

### PrintMe cloud printing

| Before you print | 100 |
| Installing the PrintMe printer driver | 101 |

### Web Services for Devices printing

| 103 |
PRINT OPTIONS

About printer drivers and printer description files

Setting print options

Print option override hierarchy

Print options and default settings

Job Info options

Media options

Layout options

Color options

Image options

Finishing options

Variable Data Printing (VDP) options

Stamping/Watermark options

Overriding print option settings

Additional information

Auto Trapping

Booklet Maker

Booklet Maker in the printer driver

Booklet Maker in Job Properties

Collate

Defining and printing custom page sizes

Document size and Paper size

Duplex printing

Fold style options

Gang-up printing

Image Enhance

Output Delivery

Punch Position and Hole Punching

Scale

Scale to fit

User Authentication

INDEX
INTRODUCTION

This document describes how to install the printer drivers and printer driver files for the Xerox EX Print Server Powered by Fiery for the Xerox Color C75 Press / Xerox Integrated Fiery Color Server. This document covers the following topics:

- Installing printer driver files on Windows computers
- Setting up the printing connections on Windows computers
- Printing from Windows computers
- Installing printer driver files on Mac OS computers
- Setting up Mac OS computers for printing
- Printing from Mac OS computers
- Xerox EX Print Server Powered by Fiery for the Xerox Color C75 Press / Xerox Integrated Fiery Color Server print options
- Using printing methods other than the printer driver to print to the Xerox EX Print Server Powered by Fiery for the Xerox Color C75 Press / Xerox Integrated Fiery Color Server

For information about setting up network servers and client computers to use the Xerox EX Print Server Powered by Fiery for the Xerox Color C75 Press / Xerox Integrated Fiery Color Server, see Configuration and Setup. For general information about using the color press, your computer, application software, or network, see the documentation that accompanies those products.

For information about supported operating systems and system requirements, see Configuration and Setup.
## Terminology and conventions

This document uses the following terminology and conventions.

<table>
<thead>
<tr>
<th>Term or convention</th>
<th>Refers to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aero</td>
<td>Fiery server (in illustrations and examples)</td>
</tr>
<tr>
<td>Color press</td>
<td>Xerox Color C75 Press</td>
</tr>
<tr>
<td>Fiery server</td>
<td>Xerox EX Print Server Powered by Fiery for the Xerox Color C75 Press / Xerox Integrated Fiery Color Server</td>
</tr>
<tr>
<td>Titles in italics</td>
<td>Documents in this set: <em>Color Printing, Configuration and Setup, Fiery Color Reference, Fiery Graphic Arts Package, Printing, Utilities, Variable Data Printing, Workflow Examples</em></td>
</tr>
<tr>
<td>Tips and information</td>
<td>Topics for which additional information is available by starting Help in the software</td>
</tr>
</tbody>
</table>

### Notes:

- **WARNING**: A warning concerning operations that may lead to death or injury to persons if not performed correctly. To use the equipment safely, always pay attention to these warnings.

- **CAUTION**: A caution concerning operations that may lead to injury to persons if not performed correctly. To use the equipment safely, always pay attention to these cautions.

- **IMPORTANT**: Operational requirements and restrictions. Be sure to read these items carefully to operate the equipment correctly, and avoid damage to the equipment or property.
**User software for printing**

The following table lists the user software that is described in this document. This is the user software you need for setting up basic printing on the Fiery server. Other documents may describe user software that can be used to print documents.

<table>
<thead>
<tr>
<th>User software</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer driver files</td>
<td>Provides information about the Fiery server and your particular color press model to your application and printer driver.</td>
</tr>
<tr>
<td>PageMaker PPD files</td>
<td>Allow you to print to the Fiery server from Adobe PageMaker. You must install the appropriate PPD in PageMaker. For instructions, see the documentation that accompanies PageMaker.</td>
</tr>
<tr>
<td>Job Monitor (for Windows)</td>
<td>Monitors the status of each connected Fiery server and the print jobs sent to it. Job Monitor is automatically installed when the printer driver is installed on a Windows computer. For more information, see &quot;Configuring and using Job Monitor&quot; on page 30 and page 56.</td>
</tr>
<tr>
<td>Printer Delete Utility (for Windows)</td>
<td>Uninstalls the Windows printer driver. For more information, see &quot;Uninstalling printer drivers&quot; on page 21.</td>
</tr>
<tr>
<td>Fiery Software Uninstaller Utility (for Mac OS)</td>
<td>Uninstalls the Mac OS printer and associated printer driver files. For more information, see &quot;Uninstalling printer driver files&quot; on page 66.</td>
</tr>
</tbody>
</table>
Windows for EX Print Server

To set up the Fiery server as a color press on a Windows computer, install the printer driver files that correspond to your color press and set up the Fiery server for printing. Printer drivers provide a way to communicate information about print jobs between your applications, the Fiery server, and the color press.

For the location of each procedure, see the following table.

<table>
<thead>
<tr>
<th>Procedure</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing Windows printer drivers</td>
<td>page 10</td>
</tr>
<tr>
<td>Setting up the Windows computer for printing</td>
<td>page 22</td>
</tr>
<tr>
<td>Printing from Windows computers</td>
<td>page 31</td>
</tr>
</tbody>
</table>

**Installing Windows printer drivers**

Installing printer drivers and printer driver files is the first step in setting up the Fiery server as a PostScript printer.

**NOTE:** Windows 8, Windows 7, Windows Vista, Windows Server 2008 R2, and Windows Server 2012 have a User Account Control (UAC) feature. You must be the administrator or a user with Administrator privileges to install printer drivers.

**NOTE:** If the Fiery server printer driver is already installed, you must uninstall it before you install a new driver (see “Uninstalling printer drivers” on page 21).

The following sections describe how to install the printer driver files for the Fiery server.

<table>
<thead>
<tr>
<th>Procedure</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing printer drivers with Point and Print</td>
<td>page 11</td>
</tr>
<tr>
<td>Downloading printer drivers with WebTools</td>
<td>page 13</td>
</tr>
<tr>
<td>Downloading printer drivers from the Fiery server</td>
<td>page 14</td>
</tr>
<tr>
<td>Installing printer drivers from the User Software DVD</td>
<td>page 15</td>
</tr>
<tr>
<td>Installing the printer driver on a 64-bit Windows computer from a 32-bit Windows Server 2003 server</td>
<td>page 17</td>
</tr>
<tr>
<td>Installing and connecting to a virtual printer</td>
<td>page 18</td>
</tr>
<tr>
<td>Uninstalling printer drivers</td>
<td>page 21</td>
</tr>
</tbody>
</table>
Installing printer drivers with Point and Print

SMB printing (also known as Windows or WINS printing) allows you to install PostScript printer drivers on your computer from the Fiery server with Point and Print, and print to a particular connection (Print queue, Hold queue, Direct connection, Sequential Print queue, or Virtual Printer).

Sequential Print allows the Fiery server to maintain the job order on certain jobs sent from the network. The workflow is 'First In, First Out' (FIFO), respecting the order in which the jobs were received over the network. For more information, see Command WorkStation Help.

Each connection (print, hold, direct, sequential print or the name of the virtual printer) requires a separate installation. Repeat the procedure for each connection.

When you install the printer driver using Point and Print, you cannot configure installable options manually. The installed options are displayed as the Fiery server configuration in the printer driver. For more information, see “Configuring installable options” on page 29.

**BEFORE YOU BEGIN**

Ask your administrator to do the following in Setup on the Fiery server:

- **Assign the Fiery server a valid IP address.**

  The IP address or DNS name is required in the following procedure.

- **Configure the Fiery server for SMB printing.**

  **NOTE:** SMB printing is referred to as Windows Printing in Setup and on the Configuration page.

  For more information, see Configuration and Setup or Configure Help.

**TO SET UP SMB PRINTING ON WINDOWS COMPUTERS**

1. **Windows 8/Server 2012:** Press the Windows button on the keyboard to open the Start screen. Open Search by pointing to the lower-right corner of the screen and moving the mouse pointer up, click Control Panel, and then click Network and Sharing Center. Type network in the Search field to view all options, and then click View network computer and devices from the Network and Sharing list.

   **Windows XP/Server 2003:** Right-click Network Neighborhood or My Network Places, and then select Find Computer or Search for Computers.

   **Windows Vista/Server 2008:** Click Start, click Control Panel, double-click Network and Sharing Center, and then click the View computers and devices link.

   **Windows 7/Server 2008 R2:** Click Start, click Control Panel, click Network and Internet, click Network and Sharing Center, and then click the View network computers and devices link.
2 Windows 8/Server 2012: Type the name of the Fiery server in the Search field and click Enter.
Windows XP/Server 2003: Type the name or IP address of the Fiery server and click Search Now or Search.
Windows Vista/Windows 7/Server 2008/Server 2008 R2: Type the name of the Fiery server in the Search field and click Enter.

If you cannot locate the Fiery server, contact your Fiery server administrator.

3 Double-click the name of the Fiery server to display active print connections.

**NOTE:** For a description of each print connection, see *Configuration and Setup.*

4 Double-click the connection that you want to set up (print, hold, direct, sequential print or virtual printer).

The files are installed on your computer.

**NOTE:** You may receive a message that you are about to connect to a printer on the Fiery server, which will automatically install a printer driver on your computer. Click Yes to continue.

5 Windows 8/Server 2012: Press the Windows button on the keyboard to open the Start screen. Open Settings by pointing to the lower-right corner of the screen and moving the mouse pointer up, click Control Panel, and then click Devices and Printers.
Windows XP: Click Start and choose Printers and Faxes.
Windows Vista: Click Start, choose Control Panel, and then double-click Printers.
Windows 7/Server 2008 R2: Click Start and choose Devices and Printers.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.
Windows Server 2008: Click Start, choose Control Panel, and under Classic View, double-click Printers.

The printer is displayed in the Printers or Printers and Faxes window.

Windows 8/Server 2012: Right-click the Fiery server icon and choose Printer properties.

7 Click Print Test Page on the General tab.

If the Test Page prints successfully, you are ready to print from the computer.

8 Repeat the previous steps for the other connections that you want to set up.
Downloading printer drivers with WebTools

WebTools allow you to download printer driver installers to your computer directly from the Fiery server, if your administrator has turned on access to WebTools.

For information about Setup, see Configuration and Setup.
For information about setting up and starting WebTools, see Utilities.

To download printer driver files with WebTools

1 Start your Internet or intranet browser and type the DNS name or IP address of the Fiery server.
2 Click the Downloads tab.
3 Click the link for the item that you want to install.
   For Windows printer drivers, click the Printer Files link under the Windows heading.
4 If a dialog box prompts you to open the file or save it to disk, save it to disk.
5 Browse to the location where you want to save the PRNTDRV.EXE file and click Save.
   The file is downloaded from the Fiery server. This compressed file is an archive that contains multiple files.
6 Double-click the PRNTDRV.EXE file to extract the files.
   Depending on your operating system, you might be prompted to select a location to extract the files.
   After the files are copied to the specified location, the Fiery Driver Installer starts automatically.

   **NOTE:** Windows 8, Windows 7, Windows Vista, Windows Server 2008 R2, and Windows Server 2012 have a User Account Control (UAC) feature. You must be the administrator or a user with Administrator privileges to install printer drivers. Right-click PRNTDRV.EXE and select Run as administrator.

   Follow the instructions for your operating system to install the printer driver. The procedures are the same as for installing from the DVD. For instructions on installing the Windows printer driver, see “To install and complete the print connection for Windows” on page 15, step 2.

   For more information, see WebTools Downloads Help.
Downloading printer drivers from the Fiery server

You can download printer driver files to your computer directly from the Fiery server over the network, and then install them following the procedures in “Installing printer drivers from the User Software DVD or downloaded from WebTools” on page 15.

TO DOWNLOAD PRINTER DRIVER FILES FROM THE FIERY SERVER

1. **Windows 8/Server 2012:** Press the Windows button on the keyboard to open the Start screen. Open Search by pointing to the lower-right corner of the screen and moving the mouse pointer up, click Control Panel, and then click Network and Sharing Center. Type network in the Search field to view all options, and then click View network computer and devices from the Network and Sharing list.
   
   
   Windows Vista/Server 2008: Click Start, choose Control Panel, double-click Network and Sharing Center, and then click the View computers and devices link.
   
   Windows 7/Server 2008 R2: Click Start, choose Control Panel, choose Network and Internet, choose Network and Sharing Center, and then click the View network computers and devices link.

2. **Windows 8/Server 2012:** Type the name of the Fiery server in the Search field and click Enter.
   
   Windows XP/Server 2003: Type the name or IP address of the Fiery server and click Search Now or Search.
   
   Windows Vista/Windows 7/Server 2008/Server 2008 R2: Type the name of the Fiery server in the Search field and click Enter.

   If you cannot locate your Fiery server, contact your administrator.

3. **Double-click the name of the Fiery server.**

   A folder called PC_User_SW is displayed along with the active print connections.

4. **Double-click the PC_User_SW folder and browse to the Print Drivers\Ps_drvr folder.**

   Follow the instructions for your operating system to install the printer driver. The procedures are the same as for installing from the DVD.
Installing printer drivers from the User Software DVD or downloaded from WebTools

The following procedures describe installing the printer driver from the User Software DVD or the printer driver files downloaded from WebTools.

To install the printer driver on a Windows 8, Windows 7 or Windows Server 2003/2008/2008 R2/2012 computer, select the same printer driver file as for Windows XP/Vista, described in the following procedure.

**NOTE:** The following procedures use Windows XP illustrations.

This procedure describes the installation of a local printer (Port 9100). You can modify the printing protocol later, according to your network type.

---

**To install and complete the print connection for Windows**

1. Insert the User Software DVD into the DVD drive, type the name of the DVD drive (for example, D:\), browse to the Print Drivers\Driver_Installer folder, and double-click setup.exe.

   **NOTE:** When you insert the User Software DVD into the DVD drive, the Fiery Driver Installer may start automatically.

   Or

   From WebTools, after the printer driver files are copied to the specified location, the Fiery Driver Installer starts automatically.

2. In the Fiery Driver Installer dialog box, select the printer driver language and click Next.

   The Fiery Driver Installer installation wizard appears.

3. Click Next in the Welcome to the InstallShield Wizard for Fiery Driver Installer dialog box.

4. Read the license agreement, click “I accept the terms of the license agreement” and click Next.

5. Windows XP/Server 2003: Click Next in the Welcome to the Add Printer Wizard dialog box.

   Windows 8/Server 2012: Click “The printer that I want isn’t listed.”


   Windows 8/Server 2012: Select Add a local printer or network printer with manual settings.

7. Select Create a new port, select Standard TCP/IP Port from the Type of port menu, and then click Next.


   Windows 7/Vista/Server 2008/Server 2008 R2: Type the host name or IP address of the Fiery server, and then click Next. Proceed to step 11.
Windows 8/Server 2012: Type the host name or IP address of the Fiery server. Select the Query the printer and automatically select the driver to use check box. Click Next and proceed to step 11.

9 Windows XP/Server 2003: Type the printer name or IP address of the Fiery server and click Next.

10 Windows XP/Server 2003: Click Finish to close the Add Standard TCP/IP Printer Port Wizard dialog box.

**NOTE:** If the device is not found on the network, the device is displayed, instead of the Finish button. If a device is not found on the network, that could be for one of the following reasons:

- Fiery server is not turned on.
- Network is not connected.
- Fiery server is not configured properly.
- IP address is not correct.

If you encounter one of these situations, you can continue to set up the port by configuring the port manually. See “To set up Standard TCP/IP Port (Raw or LPR) for Windows” on page 23 and follow steps 11 through 14 before proceeding to step 11.

11 **In the Printers box, select your printer and click Next.**

**NOTE:** Select the printer driver with “US” for North America (the default Document Size is Letter) or without “US” for International (the default Document Size is A4).

12 **Type a name for the Fiery server in the Printer name field, and click Next.**

This name is used in the Printers window and the queues window.
13 Follow the on-screen instructions.

Indicate whether you want to make it the default printer. Do not share the printer and do not print a Test Page at this time.

Continue with the printer driver installation and at the last screen, click Finish.

The necessary files are installed on your hard disk drive.

14 Configure the installable options.

For more information, see “Configuring installable options” on page 29.

15 To set up a connection other than Port 9100, proceed to “Setting up printing connections” on page 22.

16 To use the printer driver, you must select the following options on the Advanced tab of the printer driver:

- Spool print documents
- Start printing immediately
- Print spooled documents first

Installing the printer driver on a 64-bit Windows computer from a 32-bit Windows Server 2003 computer

If your network users print to the Fiery server with Windows Server 2003 (32-bit) print sharing, and 64-bit Windows XP users are also on your network, you must add the 64-bit printer driver to the Windows Server 2003 (32-bit) computer, so that users can install the printer driver on their computers using Point and Print. We do not recommend installing the printer driver from a server (32-bit) to client computer (64-bit). When you install the 64-bit printer driver to the computer (32-bit), the Windows Server 2003 (64-bit) CD is required.

---

**To add the 64-bit printer driver to a 32-bit Windows Server 2003 computer**

1 Install the Fiery server printer driver on the Windows Server 2003 computer.

   For instructions, see “Installing printer drivers from the User Software DVD or downloaded from WebTools” on page 15. During the installation, when asked if you want to share the printer, select Yes.

2 In the Printer & Faxes window, right-click the printer that you just installed and select Properties.

3 Click the Sharing tab and click Additional Drivers.

4 Select the x64 components and click OK.

5 Browse to the printer driver files and select the oemsetup.inf file.
6 When prompted, insert the Windows Server 2003 x64 Installation CD into the drive of the computer running Windows Server 2003.

7 On the CD, browse to the AMD64 folder and click OK.

The printer driver installation is complete.

Installing and connecting to a virtual printer

A virtual printer allows you to print to the Fiery server using a predefined set of job settings. You do not have to set print options manually. Before you can print to a virtual printer, the administrator must create and configure the virtual printer using Command WorkStation. After the virtual printer is set up, you can install the printer driver and printer description files on your computer from the Fiery server using Point and Print.

For more information about setting up virtual printers, see Command WorkStation Help.

When you install the printer driver with Point and Print, you cannot configure installable options manually. Installable options are configured automatically. The installed options are displayed in the printer driver when you select the Two-Way Communication option.

To set up a virtual printer on Windows computers with Point and Print

1 Windows 8/Server 2012: Press the Windows button on the keyboard to open the Start screen. Open Search by pointing to the lower-right corner of the screen and moving the mouse pointer up, click Control Panel, and then click Network and Sharing Center. Type network in the Search field to view all options, and then click View network computer and devices from the Network and Sharing list.


Windows Vista/Server 2008: Right-click Network and select Open from the menu.

Windows 7/Server 2008 R2: Click Start, click Control Panel, click Network and Internet, click Network and Sharing Center, and then click the View network computers and devices link.

2 Windows 8/Server 2012: Type the name of the Fiery server in the Search field and click Enter.

Windows XP/Server 2003: Type the name or IP address of the Fiery server and click Search Now or Search.

Windows 7/Vista/Server 2008/Server 2008 R2: Type the name of the Fiery server in the Search field and click Enter.

If you cannot locate the Fiery server, contact your network administrator.

3 Double-click the Fiery server name to display active print connections.

Virtual printers are listed along with the Print queue, Hold queue, Direct connection, and Sequential Print queue (if those connections are active). Virtual printers are usually assigned names that indicate the type of job for which they are set up.

4 Right-click the virtual printer that you want and select Connect.

The files are installed on your computer.
5 Windows 8/Server 2012: Press the Windows button on the keyboard to open the Start screen. Open Search by pointing to the lower-right corner of the screen and moving the mouse pointer up, click Control Panel, and then click Devices and Printers.
Windows XP: Click Start and click Printers and Faxes.
Windows Vista: Click Start, click Control Panel, and then double-click Printers.
Windows 7/Server 2008 R2: Click Start and click Devices and Printers.
Windows Server 2003: Click Start, click Control Panel, and then click Printers and Faxes.
Windows Server 2008: Click Start, click Control Panel, and under Classic View, double-click Printers.

The virtual printer is displayed in the Printers (or Printers and Faxes or Devices and Printers) window.

You can print to a virtual printer as you would print to the Fiery server. Depending on how the virtual printer is configured, you may not be able to set some print options.

**NOTE:** If you use Command WorkStation to import a PostScript file to a virtual printer and the file already specifies the number of copies, the setting for the number of copies in the PostScript file takes precedence over the number of copies set in the virtual printer.

**NOTE:** When you print to a virtual printer installed with Point and Print, you must open the Printing Preferences window and click OK before the job is printed. This applies the virtual printer settings to the job.
Turning on Two-Way Communication

You must turn on the Two-Way Communication option to automatically update your printer driver to reflect the options currently installed on the color press.

**NOTE:** You must log on with Administrator privileges to add or change the installable options after the Windows 8, Windows 7, Windows Vista, Windows Server 2008 R2, or Windows Server 2012 printer driver is installed. For more information, see “Configuring installable options” on page 29.

---

**To turn on Two-Way Communication**

1. **Windows 8/Server 2012:** Press the Windows button on the keyboard to open the Start screen. Open Search by pointing to the lower-right corner of the screen and moving the mouse pointer up, click Control Panel, and then click Devices and Printers.
   - **Windows XP:** Click Start and click Printers and Faxes.
   - **Windows Vista:** Click Start, click Control Panel, and then double-click Printers.
   - **Windows 7/Server 2008 R2:** Click Start and click Devices and Printers.
   - **Windows Server 2003:** Click Start, click Control Panel, and then click Printers and Faxes.
   - **Windows Server 2008:** Click Start, click Control Panel, and under Classic View, double-click Printers.

   - **Windows 8/7/Server 2008 R2/Server 2012:** Right-click the Fiery server icon and select Printer properties.

3. Click the Accessories tab.

4. Select the Two-Way Communication check box.

5. Type the Fiery server IP address or DNS name.

6. Select Update Fiery Driver When Opened to display the printer’s current default settings when the printer driver is opened.

7. Click Update.

   **NOTE:** To confirm that Two-Way Communication is turned on, click the About tab and check that the Fiery server name and other server information are displayed.

8. Click OK.
Uninstalling printer drivers

The Printer Delete Utility is installed and used locally. You do not need to connect to the Fiery server before you use the software.

To install and use the Fiery Printer Delete Utility

1 Install the Fiery Printer Delete Utility using one of the following methods:

   • Download the Client Software Installer for Windows from WebTools.

      Start your Internet or intranet browser and type the DNS name or IP address of the Fiery server. Click the Downloads tab. Click the link to install and follow the on-screen instructions.

   • Insert the User Software DVD into the DVD drive of the computer.

      The Fiery Installer starts automatically.

2 In the window that appears, select Modify, and then click Next.

3 Select the Fiery Printer Delete Utility check box, and follow the on-screen installation instructions.

4 Click Start, select Programs or All Programs, and then select Fiery.

5 Select PrinterDeleteUtility.

   The Printer Delete Utility dialog box appears. Any Fiery server printer drivers found on your computer are listed.

6 To delete a printer, select the check box next to the printer name and click Delete the Selected Printers.

   To delete all of the installed printer drivers, select the Delete All Printer Drivers check box, and click OK.

7 When you finish deleting printer drivers, click Exit and restart your computer.
Setting up the Windows computer for printing

Now that the printer driver files are installed, you need to configure the proper connection for your networked Fiery server printer.

To print from Windows computers, you or the administrator must perform the following tasks to set up a connection other than Port 9100:

- Set up network servers, if any.
- Set up the Fiery server to accept print jobs from your computer.
- Configure a port on each Windows computer for the network type.

Setting up printing connections

The Fiery server supports the following printing connections:

- SMB
- Standard TCP/IP (RAW or LPR)
- IPP or IPP over SSL
- FTP

For the location of each procedure, see the following table.

<table>
<thead>
<tr>
<th>Procedure</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completing the SMB printing connection</td>
<td>page 22</td>
</tr>
<tr>
<td>Completing Standard TCP/IP Port (Raw or LPR) printing connections</td>
<td>page 23</td>
</tr>
<tr>
<td>Completing IPP connections</td>
<td>page 27</td>
</tr>
<tr>
<td>Configuring installable options</td>
<td>page 29</td>
</tr>
<tr>
<td>Configuring and using Job Monitor</td>
<td>page 30</td>
</tr>
</tbody>
</table>

Completing the SMB printing connection

If your network does not have a Windows server, Windows computers can still print to the Fiery server. This method of printing is SMB printing (also known as Windows or WINS printing). When users send print jobs, Windows computers operate in a peer-to-peer environment and communicate directly with the Fiery server.

SMB printing allows the Fiery server to be listed on the network, so that Windows client computers can print to a particular print connection (Print queue, Hold queue, Direct connection, Sequential Print queue, or Virtual Printer) on the Fiery server without using other networking software. Windows printing runs via TCP/IP. You must configure TCP/IP on the Fiery server and on all computers that use SMB printing.
After you turn on SMB printing on the Fiery server, you can set up the Windows or SMB connection and install the printer driver in one procedure. For more information, see “Installing printer drivers with Point and Print” on page 11.

Completing Standard TCP/IP Port (Raw or LPR) printing connections

After you install the PostScript and printer driver files, you can add or configure the Setup for the Standard TCP/IP Port (Raw or LPR) connection as follows:

- Prepare the Fiery server to accept print jobs using Standard TCP/IP Port (Raw or LPR) protocols.
- Turn on LPD or Port 9100 on the Fiery server.
- Configure the computer for the TCP/IP connection.

For more information about Setup, see Configure Help.

Before you complete the following procedure, contact your system administrator for the IP address assigned to the Fiery server.

The TCP/IP protocol should be installed as a default on the Windows computer. For Port 9100, you can set up the connection and install the printer driver in one procedure.

**NOTE:** You can also set up the LPR Port connection by installing Print Services for UNIX, which is supplied as an add-on Windows component. For more information, see the documentation that accompanies Windows.

---

**To set up Standard TCP/IP Port (Raw or LPR) for Windows**

**NOTE:** The following procedure uses Windows XP illustrations.

1. **Windows 8/Server 2012:** Press the Windows button on the keyboard to open the Start screen. Open Search by pointing to the lower-right corner of the screen and moving the mouse pointer up, click Control Panel, and then click Devices and Printers.
   
   **Windows XP:** Click Start and click Printers and Faxes.
   
   **Windows Vista/Server 2008:** Click Start, click Control Panel, and then double-click Printers.
   
   **Windows 7/Server 2008 R2:** Click Start and click Devices and Printers.
   
   **Windows Server 2003:** Click Start, click Control Panel, and then click Printers and Faxes.


   **Windows 8/7/Server 2008 R2/Server 2012:** Right-click the Fiery server icon and select Printer properties.
3 Click the Ports tab.

4 To add a new port, click Add Port.

To change the port settings, proceed to step 11.

5 Windows XP/Server 2003: Select Standard TCP/IP Port from the list of Available port types and click New Port.
   Windows 8/7/Server 2008 R2/Server 2012: Select Standard TCP/IP Port from the list of Available port types and click New Port.

The Add Standard TCP/IP Printer Port Wizard dialog box appears.

6 Click Next.
7 Type the Fiery server IP address.

8 Click Next.

9 Make sure that Generic Network Card is selected as Standard for Device Type and click Next.

10 Click Finish to close the Add Standard TCP/IP Printer Port Wizard dialog box, and then click Close in the Printer Ports dialog box.

To change the default setting, proceed to step 11.

If you do not want to change the default setting, the setting is now completed.

**NOTE:** Port 9100 was set as the default setting in “Installing printer drivers from the User Software DVD or downloaded from WebTools” on page 15.

11 Click Configure Port on the Ports tab of the Properties dialog box.

The Configure Standard TCP/IP Port Monitor dialog box appears.
To use LPR printing, select LPR in the Protocol area and LPR Byte Counting Enabled in the LPR Settings area.

NOTE: You can also proceed without selecting LPR Byte Counting Enabled.

To use Port 9100 printing, select Raw in the Protocol area.

The port number 9100 automatically appears in the Raw Settings area. This is the default port number. You can print to the printer connection selected for Port 9100 printing on the Fiery server.

To specify a specific port number, see the following step.

13 Type the name of the print connection.

For LPR, enter print or hold for Queue Name or published virtual printer name. The Direct connection is not supported for LPR printing.

For Port 9100, type the following port numbers for each print connection in the Raw Settings area:

Fiery server default: 9100

direct: 9101

print: 9102

hold: 9103

NOTE: Type the number exactly as shown.

14 Click OK to close the Configure Standard TCP/IP Port Monitor dialog box.


NOTE: LPR printing in the IPv6 environment is supported on the Windows XP/Server 2003 computer from a command line, but other methods may work.

15 Click Apply in the Fiery server Properties dialog box, and then click OK.
Completing IPP connections

With Internet Printing Protocol (IPP), print jobs are sent to the Fiery server over the Internet.

Before you begin, perform the following tasks:

- Make sure that the Fiery server is configured for TCP/IP printing and IPP printing.
  
  For more information, see Configure Help.

- Specify the printing destination on your computer.

**NOTE:** IPP over SSL connections is supported.

---

**To set up IPP printing with Windows**

1. **Windows 8/Server 2012:** Press the Windows button on the keyboard to open the Start screen.
   
   Open Search by pointing to the lower-right corner of the screen and moving the mouse pointer up, click Control Panel, and then click Devices and Printers.
   
   **Windows XP:** Click Start and click Printers and Faxes.
   
   **Windows Vista:** Click Start, click Control Panel, and then double-click Printers.
   
   **Windows 7/Server 2008 R2:** Click Start, click Control Panel, click Network and Internet, click Network and Sharing Center, and then click the View network computers and devices link.
   
   **Windows Server 2003:** Click Start, click Control Panel, and then click Printers and Faxes.
   
   **Windows Server 2008:** Click Start, click Control Panel, and then double-click Printers under Classic View.

2. **Windows 8/Server 2012:** Click Advanced printer setup.
   
   **Windows XP:** Double-click the Add Printer icon and click Next.
   
   **Windows 7/Vista/Server 2008/Server 2008 R2:** Click Add a printer.
   
   **Windows Server 2003:** Double-click the Add a printer icon and click Next.

3. **Windows XP/Server 2003:** Select Network printer and click Next.
   
   **Windows Vista:** Select Add a network printer.
   
   **Windows 8/7/Windows Server 2008/Server 2008 R2/Server 2012:** Select Add a network, wireless, or Bluetooth printer.

4. **Windows XP/Vista/Server 2003:** Select Connect to a printer on the Internet or your intranet.
   
   **Windows 8/7/Server 2008/Server 2008 R2/Server 2012:** If the printer search takes a long time, click Stop, and then click “The printer that I want isn’t listed.”

5. **Windows XP/Vista/Server 2003:** In the URL field, type the IP address or DNS name of the Fiery server, followed by “ipp/” and then the name of the connection (hold, direct, print, or name of virtual printer).

  For example, http://10.10.10.150/ipp/print, http://DNS name of the Fiery server/ipp/print or ipp://10.10.10.150 sends the job to the Print queue on the Fiery server.

  For IPP over SSL, type https, instead of http.
**NOTE:** The ipp/print in the example is case sensitive.

6 **Windows XP/Vista/Server 2003:** Click Next.

The Connect to Printer dialog box appears.

6 **Windows 8/7/Server 2008/Server 2008 R2/Server 2012:** Click Next.

7 **Windows XP/Vista/Server 2003:** Click OK.

The Add Printer Wizard dialog box appears.

7 **Windows 8/7/Server 2008/Server 2008 R2/Server 2012:** Click Install driver.
8 If you are installing the PostScript printer for the first time, follow the procedure “To install and complete the print connection for Windows” on page 15, step 11.

9 Indicate whether you want to make the Fiery server the default printer and click Next.

10 Click Finish.

Configuring installable options

After you complete the printer driver installation, you must configure the Fiery server for the options installed on the color press to allow the Fiery server to take advantage of the color press options. Configure the options manually, or for TCP/IP network connections, use the Two-Way Communication option to configure the options automatically.

For information about specifying installable options, see printer driver Help.

**NOTE:** Windows 8, Windows 7, Windows Vista, Windows Server 2008 R2, and Windows Server 2012 have a User Account Control (UAC) feature. You must log on with Administrator privileges to add or change the installable options after the printer driver is installed.

**TO CHANGE INSTALLABLE OPTIONS**

1 Windows Vista: Open the Printers Control Panel.

2 Windows Vista: Right-click the Fiery server printer icon, select Run as administrator, and then select Properties.
   Windows 8/7/Server 2008 R2/Server 2012: Right-click the Fiery server printer icon, select Run as administrator, and then select Printer properties.

   The User Account Control dialog box opens.

3 Select the User that has administrator privileges, type the password, and then click OK.

4 Windows Vista: Right-click the Fiery server printer icon again and select Properties.
   Windows 8/7/Server 2008 R2/Server 2012: Right-click the Fiery server printer icon again and select Printer properties.

5 Click the Accessories tab and make your selections.

6 Click Apply, and then click OK.
Configuring installable options for printer drivers installed with the Add Printer Wizard

If you install the printer driver from Add Printer Wizard and then use Two-Way Communication to configure the installable options, the installable options are not configured properly. After you install the printer driver, you must properly configure these options.

To Correctly Configure Installable Options

1. After you install the printer driver, right-click the printer icon, select Properties, click the Accessories tab, and then select your installable options.
2. Click OK or Apply.

Configuring and using Job Monitor

Use Job Monitor to monitor the status of jobs sent to the Fiery server and view information about them.

Job Monitor is supported only on Windows 32-bit version operating systems.

Configuring the connection

When you send your first print job to the Fiery server, Job Monitor opens and establishes a connection to the Fiery server. If you installed and configured printer drivers for more than one color press, Job Monitor automatically establishes a connection to each Fiery server color press.

The Job Monitor icon ( ) appears on the desktop and in the Windows taskbar of your computer.

Job Monitor is automatically installed when you select the printer driver to install on your computer. To use Job Monitor, you must turn it on in the printer driver.

To Turn on Job Monitor

- Select the Monitor my Print Job check box on the Printer tab of the printer driver.

To Turn off Job Monitor

- Clear the Monitor my Print Job check box on the Printer tab of the printer driver.

Using Job Monitor

For information about using Job Monitor, see Job Monitor Help and printer driver Help.
Printing from Windows computers

You can print to the Fiery server just as you would print to any other printer from a Windows application. You can print from a networked Windows computer or a computer using Windows (WINS) printing. Select the Fiery server as the current printer in the Printer Name list, specify print options, and then print the document from the application.

The following table includes other methods to print to the Fiery server and describes where to find information about these features.

<table>
<thead>
<tr>
<th>For more information</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Downloading files to the Fiery server using the Docs WebTool</td>
<td>Utilities</td>
</tr>
<tr>
<td>Printing documents using E-mail Services</td>
<td>“E-mail Service” on page 88</td>
</tr>
<tr>
<td>Printing documents using Hot Folders</td>
<td>Utilities</td>
</tr>
<tr>
<td>Printing documents using Command WorkStation</td>
<td>Utilities</td>
</tr>
<tr>
<td>Setting up the Windows environment for printing with Windows servers connected to the Fiery server</td>
<td>Configuration and Setup</td>
</tr>
<tr>
<td>Printing files on the USB flash drive to the Fiery server</td>
<td>page 92</td>
</tr>
<tr>
<td>PrintMe cloud printing</td>
<td>page 100</td>
</tr>
<tr>
<td>Web Services Device (WSD) printing</td>
<td>page 103</td>
</tr>
</tbody>
</table>

The following table includes information about printing and saving files, and describes where to find information about these features.

<table>
<thead>
<tr>
<th>For more information</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Achieving optimal printing results from applications</td>
<td>Color Printing and Fiery Color Reference</td>
</tr>
<tr>
<td>Setting print options and printing from Windows applications</td>
<td>page 32</td>
</tr>
<tr>
<td>Specifying default print options</td>
<td>page 35</td>
</tr>
<tr>
<td>Customizing the Quick Access icon</td>
<td>page 36</td>
</tr>
<tr>
<td>Viewing the color press status</td>
<td>page 36</td>
</tr>
<tr>
<td>Saving files to print to a remote location</td>
<td>page 36</td>
</tr>
<tr>
<td>Defining and printing custom page sizes</td>
<td>page 137</td>
</tr>
</tbody>
</table>
Setting print options and printing from Windows applications

To print from Windows applications, install the PostScript printer driver. For instructions, see “Installing Windows printer drivers” on page 10. Be sure to configure the options on the Advanced tab of the printer driver after installation is complete, as described on page 15.

If you print to a virtual printer, you may not be able to set some print options, depending on how the virtual printer is configured.

Some print options that are selectable from an application are similar to print options that are specific to the Fiery server and the color press. In these cases, use the print options specific to the Fiery server and the color press. These options appear on the Fiery Printing tab. The application may not set up the file properly for printing on the Fiery server, resulting in unexpected finishing, printing errors, or longer processing time.

If you specify incompatible print settings when printing a document, the Conflict dialog box provides instructions to resolve the conflict.

Some print options, such as expert color settings, are available only if Two-Way Communication is turned on or a particular installable option is configured. For information about Two-Way Communication, see printer driver Help. For information about configuring installable options, see page 29.

If you select Printer’s default, the job prints according to the settings that the administrator specified in Setup. For more information, see page 105.

The following procedures explain how to use the printer driver to specify print options for a particular job and print it to the Fiery server. You can also set default print settings using the driver. For information about print options, see page 104.

**NOTE:** The following procedures use Windows XP illustrations, unless specified.
To set print options for a specific Windows print job with the printer driver

1. In your application, select File > Print, and select the Fiery server as your printer.

2. Click Properties.

3. Click the Fiery Printing tab.

The Fiery Printing tab serves as the control center for all frequently used printing functions.

When you save the print options in a preset, the following option settings are not reflected:

- **Job Info options**: Schedule printing, Secure print, User Authentication password, Account ID, User ID, and Password

- **Layout option**: Impose

For information about using presets, see printer driver Help.

**NOTE:** For a list of print options, see page 106.
4 Specify print options and settings for your job.

The print options are grouped by categories. Each group or tab contains print options that are similar or complement one another.

The groups or tabs are as follows:

**Quick Access** contains duplicate print options from the other job properties groups. It is customizable, so any Job Override print option can be added or removed from the view. The Quick Access tab lets you find print options without browsing through all of the Job Properties tabs. For information about customizing the Quick Access view, see page 36.

**Job Info** contains all information about the job, including user information that may be required for user authentication, secure print properties, job handling, and document server. For information about Job Info options, see page 107.

**Media** contains attributes and sources of paper to print and insert. For information about Media options, see page 110.

**Layout** defines how the file is positioned or imaged on the media/sheet, except for positioning that compensates for finishing options, for example, Tray Alignment. For information about Layout options, see page 113.

**Color** contains color settings and graphic arts features (when activated). For information about Color options, see page 118.

**Image** contains all Image Quality settings supported by the connected Fiery server and color press. For information about Image options, see page 122.

**Finishing** contains print options that are specific to the Fiery server and to the finishing equipment on the color press. These options override settings in Fiery server Printer Setup but can be changed from Command WorkStation. For information about Finishing options, see page 124.

**VDP** contains all variable data printing (VDP) settings, such as FreeForm and advanced VDP settings. For information about VDP options, see page 126.

**Stamping** contains image stamping options that adds or hides/removes an image on the job. This also includes watermark properties that define the placement and style of the watermark. For information about Stamping/Watermark options, see page 128 or printer driver Help.

**Printer** contains color press status that includes the current paper and toner levels. For more information, see page 36 or printer driver Help.

5 After you specify the print settings, click Print to send your print job.
Specifying default print options for print jobs

To set default print options, use the following procedure.

1. **Windows 8/Server 2012**: Press the Windows button on the keyboard to open the Start screen. Open Settings by pointing to the lower-right corner of the screen and moving the mouse pointer up, click Control Panel, and then click Devices and Printers.
   - **Windows XP**: Click Start and click Printers and Faxes.
   - **Windows Vista/Server 2008**: Click Start, click Control Panel, and then double-click Printers.
   - **Windows 7/Server 2008 R2**: Click Start and click Devices and Printers.
   - **Windows Server 2003**: Click Start, click Control Panel, and then click Printers and Faxes.

2. Right-click the Fiery server icon and select Printing Preferences.

3. If the Fiery Printing tab is not displayed, click it.

4. Specify the default settings for your print job, as described on page 33.

5. Click OK to close the dialog box.
Customizing the Quick Access icon

The Quick Access icon can be customized with print options that you use frequently. This saves time because you do not have to open all of the other print option icons if you only want to set the options that you placed in Quick Access.

When you place a print option in Quick Access, it still appears under its original print option icon. You can set the option from either location.

**To customize Quick Access**

1. In your application, select File > Print and select the Fiery server as your printer.
2. Click Properties.
3. Click the Fiery Printing tab.
4. Click Customize to specify the options shown in the Customize Quick Access dialog box.

   You can select a shortcut from the Available Shortcuts list and add it to the Current Shortcuts list, as well as remove a shortcut from the Current Shortcuts list. Click OK to save your changes.

For more information about customizing Quick Access, see printer driver Help.

Viewing the color press status

If your color press is connected to a TCP/IP network, you can retrieve the color press status, including error status, levels of consumable materials, and color settings, from the Fiery server and display the status in the printer driver with the Two-Way Communication option.

For more information about Two-Way Communication and monitoring the color press status, see printer driver Help.

Saving files to print at a remote location

If you do not have an Fiery server onsite and are preparing files for a service bureau or other location, print the final files to the File port (as opposed to one of the local ports). You can also print to the File port to create a file to download using the Docs WebTool. For instructions on printing to the File port, see the documentation that accompanies Windows.
To set up the Fiery server as a color press on a Windows computer, install the printer driver files that correspond to your color press and set up the Fiery server for printing. Printer drivers provide a way to communicate information about print jobs between your applications, the Fiery server, and the color press.

For the location of each procedure, see the following table.

<table>
<thead>
<tr>
<th>Procedure</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing Windows printer drivers</td>
<td>page 37</td>
</tr>
<tr>
<td>Setting up the Windows computer for printing</td>
<td>page 48</td>
</tr>
<tr>
<td>Printing from Windows computers</td>
<td>page 57</td>
</tr>
</tbody>
</table>

### Installing Windows printer drivers

Installing printer drivers and printer driver files is the first step in setting up the Fiery server as a PostScript printer.

**NOTE:** Windows 8, Windows 7, Windows Vista, Windows Server 2008 R2, and Windows Server 2012 have a User Account Control (UAC) feature. You must be the administrator or a user with Administrator privileges to install printer drivers.

**NOTE:** If the Fiery server printer driver is already installed, you must uninstall it before you install a new driver (see “Uninstalling printer drivers” on page 47).

The following sections describe how to install the printer driver files for the Fiery server.

<table>
<thead>
<tr>
<th>Procedure</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing printer drivers with Point and Print</td>
<td>page 38</td>
</tr>
<tr>
<td>Downloading printer drivers with WebTools</td>
<td>page 40</td>
</tr>
<tr>
<td>Installing printer drivers from the User Software DVD</td>
<td>page 40</td>
</tr>
<tr>
<td>Installing the printer driver on a 64-bit Windows computer from a 32-bit Windows Server 2003 server</td>
<td>page 43</td>
</tr>
<tr>
<td>Installing and connecting to a virtual printer</td>
<td>page 44</td>
</tr>
<tr>
<td>Uninstalling printer drivers</td>
<td>page 47</td>
</tr>
</tbody>
</table>
Installing printer drivers with Point and Print

SMB printing (also known as Windows or WINS printing) allows you to install PostScript printer drivers on your computer from the Fiery server with Point and Print, and print to a particular connection (Print queue, Hold queue, Direct connection, or Virtual Printer).

Each connection (print, hold, direct or the name of the virtual printer) requires a separate installation. Repeat the procedure for each connection.

When you install the printer driver using Point and Print, you cannot configure installable options manually. The installed options are displayed as the Fiery server configuration in the printer driver. For more information, see “Configuring installable options” on page 55.

Before you begin

Ask your administrator to do the following in Setup on the Fiery server:

- **Assign the Fiery server a valid IP address.**
  
  The IP address or DNS name is required in the following procedure.

- **Configure the Fiery server for SMB printing.**

  **Note:** SMB printing is referred to as Windows Printing in Setup and on the Configuration page.

  For more information, see Configuration and Setup or Configure Help.

To set up SMB printing on Windows computers

1. Windows 8/Server 2012: Press the Windows button on the keyboard to open the Start screen. Open Search by pointing to the lower-right corner of the screen and moving the mouse pointer up, click Control Panel, and then click Network and Sharing Center. Type network in the Search field to view all options, and then click View network computer and devices from the Network and Sharing list.

   Windows XP/Server 2003: Right-click Network Neighborhood or My Network Places, and then select Find Computer or Search for Computers.

   Windows Vista/Server 2008: Click Start, click Control Panel, double-click Network and Sharing Center, and then click the View computers and devices link.

   Windows 7/Server 2008 R2: Click Start, click Control Panel, click Network and Internet, click Network and Sharing Center, and then click the View network computers and devices link.

2. Windows 8/Server 2012: Type the name of the Fiery server in the Search field and click Enter.

   Windows XP/Server 2003: Type the name or IP address of the Fiery server and click Search Now or Search.

   Windows Vista/Windows 7/Server 2008/Server 2008 R2: Type the name of the Fiery server in the Search field and click Enter.

   If you cannot locate the Fiery server, contact your Fiery server administrator.

3. Double-click the name of the Fiery server to display active print connections.
**NOTE:** Only the print connection is shown by default.

**NOTE:** For a description of each print connection, see *Configuration and Setup*.

You must now create a printer port and install the printer driver from the User Software DVD.

**NOTE:** You cannot use Point and Print to install the driver and configure the printing connection to the Fiery server in a single procedure.

4. Insert the User Software DVD into the DVD drive, type the name of the DVD drive (for example, D:\), browse to the Print Drivers\Driver_Installer folder, and double-click setup.exe.

5. In the Fiery Driver Installer dialog box, select the printer driver language and click Next.

The Fiery Driver Installer installation wizard appears.

6. Click Next in the Welcome to the InstallShield Wizard for Fiery Driver Installer dialog box.

7. Read the license agreement, click “I accept the terms of the license agreement” and click Next.

8. Windows XP/Server 2003: Click Next in the Welcome to the Add Printer Wizard dialog box.
   
   Windows 8/Server 2012: Click “The printer that I want isn’t listed.”

   
   
   Windows 8/Server 2012: Select Add a local printer or network printer with manual settings.

10. Select Create a New Port, select Local Port from the Type of port menu, and then click Next.

11. In the Port Name dialog box, type the name of the printing connection (print, hold or direct), and click OK.

12. In the Printers box, select your printer and click Next.

   **NOTE:** Select the printer driver with “US” for North America (the default Document Size is Letter) or without “US” for International (the default Document Size is A4).

13. Type a name for the Fiery server in the Printer name field, and click Next.

   This name is used in the Printers window and the queues window.

14. Follow the on-screen instructions.
Downloading printer drivers with WebTools

WebTools allow you to download printer driver installers to your computer directly from the Fiery server, if your administrator has turned on access to WebTools.

For information about Setup, see Configuration and Setup.

For information about setting up and starting WebTools, see Utilities.

To download printer driver files with WebTools

1. Start your Internet or intranet browser and type the DNS name or IP address of the Fiery server.
2. Click the Downloads tab.
3. Click the link for the item that you want to install.
   For Windows printer drivers, click the Printer Files link under the Windows heading.
4. If a dialog box prompts you to open the file or save it to disk, save it to disk.
5. Browse to the location where you want to save the PRNTDRV.EXE file and click Save.
   The file is downloaded from the Fiery server. This compressed file is an archive that contains multiple files.
6. Double-click the PRNTDRV.EXE file to extract the files.
   Depending on your operating system, you might be prompted to select a location to extract the files.

**NOTE:** Windows 8, Windows 7, Windows Vista, Windows Server 2008 R2, and Windows Server 2012 have a User Account Control (UAC) feature. You must be the administrator or a user with Administrator privileges to install printer drivers. Right-click PRNTDRV.EXE and select Run as administrator.

Follow the instructions for your operating system to install the printer driver. The procedures are the same as for installing from the DVD. For instructions on installing the Windows printer driver, see “To install and complete the print connection for Windows” on page 41, step 2.

For more information, see WebTools Downloads Help.

Installing printer drivers from the User Software DVD or downloaded from WebTools

The following procedures describe installing the printer driver from the User Software DVD or the printer driver files downloaded from WebTools.

To install the printer driver on a Windows 8, Windows 7 or Windows Server 2003/2008/2008 R2/2012 computer, select the same printer driver file as for Windows XP/Vista, described in the following procedure.
NOTE: The following procedures use Windows XP illustrations.

This procedure describes the installation of a local printer (Port 9100). You can modify the printing protocol later, according to your network type.

**TO INSTALL AND COMPLETE THE PRINT CONNECTION FOR WINDOWS**

1. Insert the User Software DVD into the DVD drive, type the name of the DVD drive (for example, D:\), browse to the Print Drivers\Driver_Installer folder, and double-click setup.exe.

   **NOTE:** When you insert the User Software DVD into the DVD drive, the Fiery Driver Installer may start automatically.

   Or

   From WebTools, after the printer driver files are copied to the specified location, the Fiery Driver Installer starts automatically.

2. In the Fiery Driver Installer dialog box, select the printer driver language and click Next.

   The Fiery Driver Installer installation wizard appears.

3. Click Next in the Welcome to the InstallShield Wizard for Fiery Driver Installer dialog box.

4. Read the license agreement, click “I accept the terms of the license agreement” and click Next.

5. Windows XP/Server 2003: Click Next in the Welcome to the Add Printer Wizard dialog box.

   Windows 8/Server 2012: Click “The printer that I want isn’t listed.”


   Windows 8/Server 2012: Select Add a local printer or network printer with manual settings.

7. Select Create a New Port, select Standard TCP/IP Port from the Type of port menu, and then click Next.


   Windows 7/Vista/Server 2008/Server 2008 R2: Type the Host name or IP address of the Fiery server, and then click Next. Proceed to step 11.

   Windows 8/Server 2012: Type the Host name or IP address of the Fiery server. Select the Query the printer and automatically select the driver to use check box. Click Next and proceed to step 11.

9. Windows XP/Server 2003: Type the printer name or IP address of the Fiery server and click Next.
10 Windows XP/Server 2003: Click Finish to close the Add Standard TCP/IP Printer Port Wizard dialog box.

**NOTE:** If the device is not found on the network, the device is displayed, instead of the Finish button. If a device is not found on the network, that could be for one of the following reasons:

- Fiery server is not turned on.
- Network is not connected.
- Fiery server is not configured properly.
- IP address is not correct.

If you encounter one of these situations, you can continue to set up the port by configuring the port manually. See “To set up Standard TCP/IP Port (Raw or LPR) for Windows” on page 49 and follow steps 11 through 14 before proceeding to step 11.

11 **In the Printers box, select your printer and click Next.**

**NOTE:** Select the printer driver with “US” for North America (the default Document Size is Letter) or without “US” for International (the default Document Size is A4).

12 **Type a name for the Fiery server in the Printer name field, and click Next.**

This name is used in the Printers window and the queues window.

13 **Follow the on-screen instructions.**

Indicate whether you want to make it the default printer. Do not share the printer and do not print a Test Page at this time.

Continue with the printer installation and at the last screen, click Finish.

The necessary files are installed on your hard disk drive.

14 **Configure the installable options.**

For more information, see “Configuring installable options” on page 55.
15 To set up a connection other than Port 9100, proceed to “Setting up printing connections” on page 48.

16 To use the printer driver, you must select the following options on the Advanced tab of the printer driver:
   • Spool print documents
   • Start printing immediately
   • Print spooled documents first

Installing the printer driver on a 64-bit Windows computer from a 32-bit Windows Server 2003 computer

If your network users print to the Fiery server with Windows Server 2003 (32-bit) print sharing, and 64-bit Windows XP users are also on your network, you must add the 64-bit printer driver to the Windows Server 2003 (32-bit) computer, so that users can install the printer driver on their computers using Point and Print. We do not recommend installing the printer driver from a server (32-bit) to client computer (64-bit). When you install the 64-bit printer driver to the computer (32-bit), the Windows Server 2003 (64-bit) CD is required.

To add the 64-bit printer driver to a 32-bit Windows Server 2003 computer

1 Install the Fiery server printer driver on the Windows Server 2003 computer.

   For instructions, see “Installing printer drivers from the User Software DVD or downloaded from WebTools” on page 40. During the installation, when asked if you want to share the printer, select Yes.

2 In the Printer & Faxes window, right-click the printer that you just installed and select Properties.

3 Click the Sharing tab and click Additional Drivers.

4 Select the x64 components and click OK.

5 Browse to the printer driver files and select the oemsetup.inf file.

6 When prompted, insert the Windows Server 2003 x64 Installation CD into the drive of the computer running Windows Server 2003.

7 On the CD, browse to the AMD64 folder and click OK.

   The printer driver installation is complete.
Installing and connecting to a virtual printer

A virtual printer allows you to print to the Fiery server using a predefined set of job settings. You do not have to set print options manually. Before you can print to a virtual printer, the administrator must create and configure the virtual printer using Command WorkStation. After the virtual printer is set up, you can install the printer driver and printer description files on your computer from the Fiery server using Point and Print.

For more information about setting up virtual printers, see Command WorkStation Help.

When you install the printer driver with Point and Print, you cannot configure installable options manually. Installable options are configured automatically. The installed options are displayed in the printer driver when you select the Two-Way Communication option.

To set up a virtual printer on Windows computers with the User Software DVD

1. Windows 8/Server 2012: Press the Windows button on the keyboard to open the Start screen. Open Search by pointing to the lower-right corner of the screen and moving the mouse pointer up, click Control Panel, and then click Network and Sharing Center. Type network in the Search field to view all options, and then click View network computer and devices from the Network and Sharing list.
   Windows Vista/Server 2008: Right-click Network and select Open from the menu.
   Windows 7/Server 2008 R2: Click Start, click Control Panel, click Network and Internet, click Network and Sharing Center, and then click the View network computers and devices link.

2. Windows 8/Server 2012: Type the name of the Fiery server in the Search field and click Enter.
   Windows XP/Server 2003: Type the name or IP address of the Fiery server and click Search Now or Search.
   Windows Vista/Windows 7/Server 2008/Server 2008 R2: Type the name of the Fiery server in the Search field and click Enter.
   If you cannot locate the Fiery server, contact your network administrator.

3. Double-click the Fiery server name to display active print connections.
   Virtual printers are listed along with the Print queue, Hold queue, and Direct connection (if those connections are active). Virtual printers are usually assigned names that indicate the type of job for which they are set up.

4. Insert the User Software DVD into the DVD drive, type the name of the DVD drive (for example, D:\), browse to the Print Drivers\Driver_Installer folder, and double-click setup.exe.
   **NOTE:** When you insert the User Software DVD into the DVD drive, the Fiery Driver Installer may start automatically.

5. In the Fiery Driver Installer dialog box, select the printer driver language and click Next.
   The Fiery Driver Installer installation wizard appears.

6. Click Next in the Welcome to the InstallShield Wizard for Fiery Driver Installer dialog box.
7 Read the license agreement, click “I accept the terms of the license agreement” and click Next.

8 Windows XP/2003: Click Next in the Welcome to the Add Printer Wizard dialog box.
Windows 8/Server 2012: Click “The printer that I want isn't listed.”

9 Windows XP/Server 2003: Specify printing using a Local printer, clear the “Automatically detect and install my Plug and Play printer” option, and then click Next.
Windows 8/Server 2012: Select Add a local printer or network printer with manual settings.

10 Select Create a New Port, select Local Port from the Type of port menu, and then click Next.

11 In the Port Name dialog box, type the name of virtual printer for the printing connection, and click OK.

12 In the Printers box, select your printer and click Next.

   **NOTE:** Select the printer driver with “US” for North America (the default Document Size is Letter) or without “US” for International (the default Document Size is A4).

13 Type a name for the Fiery server in the Printer name field, and click Next.

   This name is used in the Printers window and the queues window.

14 Follow the on-screen instructions.

   Indicate whether you want to make it the default printer. Do not share the printer and do not print a Test Page at this time.

   Continue with the printer driver installation and at the last screen, click Finish.

   The virtual printer is displayed in the Printers (or Printers and Faxes or Devices and Printers) window.

   You can print to a virtual printer as you would print to the Fiery server. Depending on how the virtual printer is configured, you may not be able to set some print options.

   **NOTE:** If you use Command WorkStation to import a PostScript file to a virtual printer and the file already specifies the number of copies, the setting for the number of copies in the PostScript file takes precedence over the number of copies set in the virtual printer.

   **NOTE:** When you print to a virtual printer installed with Point and Print, you must open the Printing Preferences window and click OK before the job is printed. This applies the virtual printer settings to the job.
Turning on Two-Way Communication

You must turn on the Two-Way Communication option to automatically update your printer driver to reflect the options currently installed on the color press.

**NOTE:** You must log on with Administrator privileges to add or change the installable options after the Windows 8, Windows 7, Windows Vista, Windows Server 2008 R2, or Windows Server 2012 printer driver is installed. For more information, see “Configuring installable options” on page 55.

---

**To turn on Two-Way Communication**

1. **Windows 8/Server 2012:** Press the Windows button on the keyboard to open the Start screen. Open Search by pointing to the lower-right corner of the screen and moving the mouse pointer up, click Control Panel, and then click Devices and Printers.
   - **Windows XP:** Click Start and click Printers and Faxes.
   - **Windows Vista:** Click Start, click Control Panel, and then double-click Printers.
   - **Windows 7/Server 2008 R2:** Click Start and click Devices and Printers.
   - **Windows Server 2003:** Click Start, click Control Panel, and then click Printers and Faxes.
   - **Windows Server 2008:** Click Start, click Control Panel, and under Classic View, double-click Printers.

   - **Windows 8/7/Server 2008 R2/Server 2012:** Right-click the Fiery server icon and select Printer properties.

3. Click the Accessories tab.

4. Select the Two-Way Communication check box.

5. Type the Fiery server IP address or DNS name.

6. Select Update Fiery Driver When Opened to display the printer’s current default settings when the printer driver is opened.

7. Click Update.

   **NOTE:** To confirm that Two-Way Communication is turned on, click the About tab and check that the Fiery server name and other server information are displayed.

8. Click OK.
Uninstalling printer drivers

The Printer Delete Utility is installed and used locally. You do not need to connect to the Fiery server before you use the software.

To install and use the Fiery Printer Delete Utility

1 Install the Fiery Printer Delete Utility using one of the following methods:

   • Download the Client Software Installer for Windows from WebTools.
     Start your Internet or intranet browser and type the DNS name or IP address of the Fiery server. Click the Downloads tab. Click the link to install and follow the on-screen instructions.
   
   • Insert the User Software DVD into the DVD drive of the computer.
     The Fiery Installer starts automatically.

2 In the window that appears, select Modify, and then click Next.

3 Select the Fiery Printer Delete Utility check box, and follow the on-screen installation instructions.

4 Click Start, select Programs or All Programs, and then select Fiery.

5 Select PrinterDeleteUtility.

   The Printer Delete Utility dialog box appears. Any Fiery server printer drivers found on your computer are listed.

   6 To delete a printer, select the check box next to the printer name and click Delete the Selected Printers.

   To delete all of the installed printer drivers, select the Delete All Printer Drivers check box, and click OK.

7 When you finish deleting printer drivers, click Exit and restart your computer.
Setting up the Windows computer for printing

Now that the printer driver files are installed, you need to configure the proper connection for your networked Fiery server printer.

To print from Windows computers, you or the administrator must perform the following tasks to set up a connection other than Port 9100:

- Set up network servers, if any.
- Set up the Fiery server to accept print jobs from your computer.
- Configure a port on each Windows computer for the network type.

Setting up printing connections

The Fiery server supports the following printing connections:

- SMB
- Standard TCP/IP (RAW or LPR)
- IPP or IPP over SSL
- FTP

For the location of each procedure, see the following table.

<table>
<thead>
<tr>
<th>Procedure</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completing the SMB printing connection</td>
<td>page 48</td>
</tr>
<tr>
<td>Completing Standard TCP/IP (Raw or LPR) printing connections</td>
<td>page 49</td>
</tr>
<tr>
<td>Completing IPP connections</td>
<td>page 53</td>
</tr>
<tr>
<td>Configuring installable options</td>
<td>page 55</td>
</tr>
<tr>
<td>Configuring and using Job Monitor</td>
<td>page 56</td>
</tr>
</tbody>
</table>

Completing the SMB printing connection

If your network does not have a Windows server, Windows computers can still print to the Fiery server. This method of printing is SMB printing (also known as Windows or WINS printing). When users send print jobs, Windows computers operate in a peer-to-peer environment and communicate directly with the Fiery server.

SMB printing allows the Fiery server to be listed on the network, so that Windows client computers can print to a particular print connection (Print queue, Hold queue, Direct connection, or Virtual Printer) on the Fiery server without using other networking software. Windows printing runs via TCP/IP. You must configure TCP/IP on the Fiery server and on all computers that use SMB printing.
After you turn on SMB printing on the Fiery server, you can set up the Windows or SMB connection and install the printer driver in one procedure. For more information, see “Installing printer drivers with Point and Print” on page 38.

**Completing Standard TCP/IP Port (Raw or LPR) printing connections**

After you install the PostScript and printer driver files, you can add or configure the Setup for the Standard TCP/IP Port (Raw or LPR) connection as follows:

- Prepare the Fiery server to accept print jobs using Standard TCP/IP Port (Raw or LPR) protocols.
- Turn on LPD or Port 9100 on the Fiery server.
- Configure the computer for the TCP/IP connection.

For more information about Setup, see Configure Help.

Before you complete the following procedure, contact your system administrator for the IP address assigned to the Fiery server.

The TCP/IP protocol should be installed as a default on the Windows computer. For Port 9100, you can set up the connection and install the printer driver in one procedure.

**NOTE:** You can also set up the LPR Port connection by installing Print Services for UNIX, which is supplied as an add-on Windows component. For more information, see the documentation that accompanies Windows.

---

**To set up Standard TCP/IP Port (Raw or LPR) for Windows**

**NOTE:** The following procedure uses Windows XP illustrations.

1. **Windows 8/Server 2012:** Press the Windows button on the keyboard to open the Start screen. Open Search by pointing to the lower-right corner of the screen and moving the mouse pointer up, click Control Panel, and then click Devices and Printers.
   - **Windows XP:** Click Start and click Printers and Faxes.
   - **Windows Vista/Server 2008:** Click Start, click Control Panel, and then double-click Printers.
   - **Windows 7/Server 2008 R2:** Click Start and click Devices and Printers.
   - **Windows Server 2003:** Click Start, click Control Panel, and then click Printers and Faxes.

   - **Windows 8/7/Server 2008 R2/Server 2012:** Right-click the Fiery server icon and select Printer properties.
3 Click the Ports tab.

![Aero Properties dialog box](image)

4 To add a new port, click Add Port.

To change the port settings, proceed to step 11.

5 Windows XP/Server 2003: Select Standard TCP/IP Port from the list of Available port types and click New Port.


Windows 8/7/Server 2008 R2/Server 2012: Select Standard TCP/IP Port from the list of Available port types and click New Port.

![Printer Ports dialog box](image)

The Add Standard TCP/IP Printer Port Wizard dialog box appears.

6 Click Next.
7 Type the Fiery server IP address.

8 Click Next.

9 Make sure that Generic Network Card is selected as Standard for Device Type and click Next.

10 Click Finish to close the Add Standard TCP/IP Printer Port Wizard dialog box, and then click Close in the Printer Ports dialog box.

   To change the default setting, proceed to step 11.

   If you do not want to change the default setting, the setting is now completed.

   **NOTE:** Port 9100 was set as the default setting in “Installing printer drivers from the User Software DVD or downloaded from WebTools” on page 40.

11 Click Configure Port on the Ports tab of the Properties dialog box.

   The Configure Standard TCP/IP Port Monitor dialog box appears.
To use LPR printing, select LPR in the Protocol area and LPR Byte Counting Enabled in the LPR Settings area.

**NOTE:** You can also proceed without selecting LPR Byte Counting Enabled.

To use Port 9100 printing, select Raw in the Protocol area.

The port number 9100 automatically appears in the Raw Settings area. This is the default port number. You can print to the printer connection selected for Port 9100 printing on the Fiery server.

To specify a specific port number, see the following step.

13 Type the name of the print connection.

For LPR, type `print`, `hold`, `direct` or `published virtual printer name` for Queue Name.

For Port 9100, type the following port numbers for each print connection in the Raw Settings area:

- Fiery server default: 9100
- direct: 9101
- print: 9102
- hold: 9103

**NOTE:** Type the number *exactly* as shown.

14 Click OK to close the Configure Standard TCP/IP Port Monitor dialog box.


**NOTE:** LPR printing in the IPv6 environment is supported on the Windows XP/Server 2003 computer from a command line, but other methods may work.

15 Click Apply in the Fiery server Properties dialog box, and then click OK.
Completing IPP connections

With Internet Printing Protocol (IPP), print jobs are sent to the Fiery server over the Internet.

Before you begin, perform the following tasks:

• Make sure that the Fiery server is configured for TCP/IP printing and IPP printing.
  For more information, see Configure Help.

• Specify the printing destination on your computer.

NOTE: IPP over SSL connections is supported.

**To set up IPP printing with Windows**

1. **Windows 8/Server 2012:** Press the Windows button on the keyboard to open the Start screen. Open Search by pointing to the lower-right corner of the screen and moving the mouse pointer up, click Control Panel, and then click Devices and Printers.
   Windows XP: Click Start and click Printers and Faxes.
   Windows Vista: Click Start, click Control Panel, and then double-click Printers.
   Windows 7/Server 2008 R2: Click Start, click Control Panel, click Network and Internet, click Network and Sharing Center, and then click the View network computers and devices link.
   Windows Server 2003: Click Start, click Control Panel, and then click Printers and Faxes.
   Windows Server 2008: Click Start, click Control Panel, and then double-click Printers under Classic View.

2. **Windows 8/Server 2012:** Click Advanced printer setup.
   Windows XP: Double-click the Add Printer icon and click Next.
   Windows Server 2003: Double-click the Add a printer icon and click Next.

3. **Windows XP/Server 2003:** Select Network printer and click Next.
   Windows Vista: Select Add a network printer.

4. **Windows XP/Vista/Server 2003:** Select Connect to a printer on the Internet or your intranet.
   Windows 8/7/Server 2008/Server 2008 R2/Server 2012: If the printer search takes a long time, click Stop, and then click “The printer that I want isn’t listed.”

5. **Windows XP/Vista/Server 2003:** In the URL field, type the IP address or DNS name of the Fiery server, followed by “ipp/” and then the name of the connection (hold, direct, print, or name of virtual printer).
   For example, http://10.10.10.150/ipp/print, http://DNS name of the Fiery server/ipp/print or ipp://10.10.10.150 sends the job to the Print queue on the Fiery server.
   For IPP over SSL, type https, instead of http.
**NOTE:** The ipp/print in the example is case sensitive.

Windows 8/7/Server 2008/Server 2008 R2/Server 2012: Click Select a Shared printer by name, and in the URL field, type the IP address or DNS name of the Fiery server, followed by the name of the connection (print, hold, or direct).

**NOTE:** For example, http://10.10.10.150/ipp/print or http://DNS name of Fiery server/ipp/print sends the job to the Print queue on the Fiery server.

**NOTE:** The URL for the printer is not case-sensitive.

6 Windows XP/Vista/Server 2003: Click Next.

The Connect to Printer dialog box appears.


7 Windows XP/Vista/Server 2003: Click OK.

The Add Printer Wizard dialog box appears.

Windows 8/7/Server 2008/Server 2008 R2/Server 2012: Click Install driver.
8 If you are installing the PostScript printer for the first time, follow the procedure “To install and complete the print connection for Windows” on page 41, step 12.

9 Indicate whether you want to make the Fiery server the default printer and click Next.

10 Click Finish.

Configuring installable options

After you complete the printer driver installation, you must configure the Fiery server for the options installed on the color press to allow the Fiery server to take advantage of the color press options. Configure the options manually, or for TCP/IP network connections, use the Two-Way Communication option to configure the options automatically.

For information about specifying installable options, see printer driver Help.

**NOTE:** Windows 8, Windows 7, Windows Vista, Windows Server 2008 R2, and Windows Server 2012 have a User Account Control (UAC) feature. You must log on with Administrator privileges to add or change the installable options after the printer driver is installed.

---

**TO CHANGE INSTALLABLE OPTIONS**

1. **Windows Vista:** Open the Printers Control Panel.
   **Windows 8/7/Server 2008 R2/Server 2012:** Open the Devices and Printers Control Panel.

2. **Windows Vista:** Right-click the Fiery server printer icon, select Run as administrator, and then select Properties.
   **Windows 8/7/Server 2008 R2/Server 2012:** Right-click the Fiery server printer icon, select Run as administrator, and then select Printer properties.

   The User Account Control dialog box opens.

3. Select the User that has administrator privileges, type the password, and then click OK.

4. **Windows Vista:** Right-click the Fiery server printer icon again and select Properties.
   **Windows 8/7/Server 2008 R2/Server 2012:** Right-click the Fiery server printer icon again and select Printer properties.

5. Click the Accessories tab and make your selections.

6. Click Apply, and then click OK.
Configuring installable options for printer drivers installed with the Add Printer Wizard

If you install the printer driver from Add Printer Wizard and then use Two-Way Communication to configure the installable options, the installable options are not configured properly. After you install the printer driver, you must properly configure these options.

**To correctly configure installable options**

1. After you install the printer driver, right-click the printer icon, select Properties, click the Accessories tab, and then select your installable options.

2. Click OK or Apply.

Configuring and using Job Monitor

Use Job Monitor to monitor the status of jobs sent to the Fiery server and view information about them.

Job Monitor is supported only on Windows 32-bit version operating systems.

Configuring the connection

When you send your first print job to the Fiery server, Job Monitor opens and establishes a connection to the Fiery server. If you installed and configured printer drivers for more than one color press, Job Monitor automatically establishes a connection to each Fiery server color press.

The Job Monitor icon ( ) appears on the desktop and in the Windows taskbar of your computer.

Job Monitor is automatically installed when you select the printer driver to install on your computer. To use Job Monitor, you must turn it on in the printer driver.

**To turn on Job Monitor**

- Select the Monitor my Print Job check box on the Printer tab of the printer driver.

**To turn off Job Monitor**

- Clear the Monitor my Print Job check box on the Printer tab of the printer driver.

Using Job Monitor

For information about using Job Monitor, see Job Monitor Help and printer driver Help.
Printing from Windows computers

You can print to the Fiery server just as you would print to any other printer from a Windows application. You can print from a networked Windows computer or a computer using Windows (WINS) printing. Select the Fiery server as the current printer in the Printer Name list, specify print options, and then print the document from the application.

The following table includes other methods to print to the Fiery server and describes where to find information about these features.

<table>
<thead>
<tr>
<th>For more information</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Downloading files to the Fiery server using the Docs WebTool</td>
<td>Utilities</td>
</tr>
<tr>
<td>Printing documents using E-mail Services</td>
<td>&quot;E-mail Service&quot; on page 88</td>
</tr>
<tr>
<td>Printing documents using Hot Folders</td>
<td>Utilities</td>
</tr>
<tr>
<td>Printing documents using Command WorkStation</td>
<td>Utilities</td>
</tr>
<tr>
<td>Setting up the Windows environment for printing with Windows servers connected to the Fiery server</td>
<td>Configuration and Setup</td>
</tr>
<tr>
<td>Printing files on a USB flash drive to the Fiery server</td>
<td>page 92</td>
</tr>
<tr>
<td>PrintMe cloud printing</td>
<td>page 100</td>
</tr>
<tr>
<td>Web Services Device (WSD) printing</td>
<td>page 103</td>
</tr>
</tbody>
</table>

The following table includes information on printing and saving files, and describes where to find information about these features.

<table>
<thead>
<tr>
<th>For more information</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Achieving optimal printing results from applications</td>
<td>Color Printing and Fiery Color Reference</td>
</tr>
<tr>
<td>Setting print options and printing from Windows applications</td>
<td>page 58</td>
</tr>
<tr>
<td>Specifying default print options</td>
<td>page 61</td>
</tr>
<tr>
<td>Customizing the Quick Access icon</td>
<td>page 62</td>
</tr>
<tr>
<td>Viewing the color press status</td>
<td>page 62</td>
</tr>
<tr>
<td>Saving files to print to a remote location</td>
<td>page 62</td>
</tr>
<tr>
<td>Defining and printing custom page sizes</td>
<td>page 137</td>
</tr>
</tbody>
</table>
Setting print options and printing from Windows applications

To print from Windows applications, install the PostScript printer driver. For instructions, see “Installing Windows printer drivers” on page 37. Be sure to configure the options on the Advanced tab of the printer driver after installation is complete, as described on page 40.

If you print to a virtual printer, you may not be able to set some print options, depending on how the virtual printer is configured.

Some print options that are selectable from an application are similar to print options that are specific to the Fiery server and the color press. In these cases, use the print options specific to the Fiery server and the color press. These options appear on the Fiery Printing tab. The application may not set up the file properly for printing on the Fiery server, resulting in unexpected finishing, printing errors, or longer processing time.

If you specify incompatible print settings when printing a document, the Conflict dialog box provides instructions to resolve the conflict.

Some print options, such as expert color settings, are available only if Two-Way Communication is turned on or a particular installable option is configured. For information about Two-Way Communication, see printer driver Help. For information about configuring installable options, see page 55.

If you select Printer’s default, the job prints according to the settings that the administrator specified in Setup. For more information, see page 105.

The following procedures explain how to use the printer driver to specify print options for a particular job and print it to the Fiery server. You can also set default print settings using the driver. For information about print options, see page 104.

**NOTE**: The following procedures use Windows XP illustrations, unless specified.
**To set print options for a specific Windows print job with the printer driver**

1. In your application, select File > Print, and select the Fiery server as your printer.
2. Click Properties.
3. Click the Fiery Printing tab.

The Fiery Printing tab serves as the control center for all frequently used printing functions.

When you save the print options in a preset, the following option settings are not reflected:

- **Job Info options**: Schedule printing, Secure print, User Authentication password, Account ID, User ID, and Password
- **Layout option**: Impose

For information about using presets, see printer driver Help.

**NOTE**: For a list of print options, see page 106.
4 Specify print options and settings for your job.

The print options are grouped by categories. Each group or tab contains print options that are similar or complement one another.

The groups or tabs are as follows:

**Quick Access** contains duplicate print options from the other job properties groups. It is customizable, so any Job Override print option can be added or removed from the view. The Quick Access tab lets you find print options without browsing through all of the Job Properties tabs. For information about customizing the Quick Access view, see page 62.

**Job Info** contains all information about the job, including user information that may be required for user authentication, secure print properties, job handling, and document server. For information about Job Info options, see page 107.

**Media** contains attributes and sources of paper to print and insert. For information about Media options, see page 110.

**Layout** defines how the file is positioned or imaged on the media/sheet, except for positioning that compensates for finishing options, for example, Tray Alignment. For information about Layout options, see page 113.

**Color** contains color settings and graphic arts features (when activated). For information about Color options, see page 118.

**Image** contains all Image Quality settings supported by the connected Fiery server and color press. For information about Image options, see page 122.

**Finishing** contains print options that are specific to the Fiery server and to the finishing equipment on the color press. These options override settings in Fiery server Printer Setup but can be changed from Command WorkStation. For information about Finishing options, see page 124.

**VDP** contains all variable data printing (VDP) settings, such as FreeForm and advanced VDP settings. For information about VDP options, see page 126.

**Stamping** contains image stamping options that adds or hides/removes an image on the job. This also includes watermark properties that define the placement and style of the watermark. For information about Stamping/Watermark options, see page 128 or printer driver Help.

**Printer** contains color press status that includes the current paper and toner levels. For more information, see page 62 or printer driver Help.

5 After you specify the print settings, click Print to send your print job.
Specifying default print options for print jobs

To set default print options, use the following procedure.

1. Right-click the Fiery server icon and select Printing Preferences.
2. If the Fiery Printing tab is not displayed, click it.
3. Specify the default settings for your print job, as described on page 59.
4. Click OK to close the dialog box.
Customizing the Quick Access icon

The Quick Access icon can be customized with print options that you use frequently. This saves time because you do not have to open all of the other print option icons if you only want to set the options that you placed in Quick Access.

When you place a print option in Quick Access, it still appears under its original print option icon. You can set the option from either location.

**To customize Quick Access**

1. In your application, select File > Print and select the Fiery server as your printer.
2. Click Properties.
3. Click the Fiery Printing tab.
4. Click Customize to specify the options shown in the Customize Quick Access dialog box.

   You can select a shortcut from the Available Shortcuts list and add it to the Current Shortcuts list, as well as remove a shortcut from the Current Shortcuts list. Click OK to save your changes.

For more information about customizing Quick Access, see printer driver Help.

Viewing the color press status

If your color press is connected to a TCP/IP network, you can retrieve the color press status, including error status, levels of consumable materials, and color settings, from the Fiery server and display the status in the printer driver with the Two-Way Communication option.

For more information about Two-Way Communication and monitoring the color press status, see printer driver Help.

Saving files to print at a remote location

If you do not have an Fiery server onsite and are preparing files for a service bureau or other location, print the final files to the File port (as opposed to one of the local ports). You can also print to the File port to create a file to download using the Docs WebTool. For instructions on printing to the File port, see the documentation that accompanies Windows.
To set up the Fiery server as a PostScript printer on a Mac OS computer, install the printer driver files that correspond to your color press and set up the Fiery server for printing. Printer drivers provide a way to communicate information about print jobs between your applications, the Fiery server, and the color press.

For the location of each procedure, see the following table.

<table>
<thead>
<tr>
<th>Procedure</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing Mac OS printer driver files</td>
<td>page 63</td>
</tr>
<tr>
<td>Setting up Mac OS computers for printing</td>
<td>page 67</td>
</tr>
<tr>
<td>Printing from Mac OS computers</td>
<td>page 82</td>
</tr>
</tbody>
</table>

### Installing Mac OS printer driver files

Installing printer driver files is the first step in setting up the Fiery server as a printer.

**NOTE:** If the Fiery server printer driver is already installed, you must uninstall it before you install a new driver (see “Uninstalling printer driver files” on page 66).

The following sections describe how to install the printer files for the Fiery server.

<table>
<thead>
<tr>
<th>Procedure</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing printer drivers from the User Software DVD</td>
<td>page 64</td>
</tr>
<tr>
<td>Downloading printer drivers with WebTools</td>
<td>page 64</td>
</tr>
<tr>
<td>Downloading printer drivers from the Fiery server</td>
<td>page 65</td>
</tr>
<tr>
<td>Uninstalling printer driver files</td>
<td>page 66</td>
</tr>
</tbody>
</table>
Installing printer drivers from the User Software DVD

The User Software DVD provides the software for Mac OS computers, such as the printer drivers.

**TO INSTALL MAC OS PRINTER DRIVER FILES**

1. Quit all open applications.
2. Insert the User Software DVD into the DVD drive.
3. Double-click Fiery Printer Driver Installer.dmg and then the Fiery Printer Driver Installer icon.
4. Read the license and click Agree.
5. Follow the on-screen instructions.

The Fiery Printer Driver Installer installs the printer driver files that correspond to the Fiery server.

**Downloading printer drivers with WebTools**

WebTools allow you to download printer driver installers to your computer directly from the Fiery server, if your administrator has configured access to WebTools. For more information about setting up and starting WebTools, see *Utilities*.

**NOTE:** A link to WebTools in the About tab of Job Properties is not available from the Mac OS X v10.7 and v10.8 printer drivers.

**TO DOWNLOAD PRINTER DRIVERS WITH WEBTOOLS**

1. Start your Internet or intranet browser and type the DNS name or IP address of the Fiery server.
2. Click the Downloads tab.
3. Click the Printer Files link for Mac OS X.
   
   A file named OSX.dmg is downloaded to your desktop.
   
   **NOTE:** If the file is not on the desktop, open the Downloads folder.
4. Double-click OSX.dmg and then the Fiery Printer Driver Installer icon.
5. Read the license and click Agree.
6. Follow the on-screen instructions.
Downloading printer drivers from the Fiery server

You can download printer driver files to your computer directly from the Fiery server over the network.

To download printer driver files from the Fiery server

1. In the Finder, choose Connect to Server from the Go menu.
2. Type SMB:// followed by the name or IP address of the Fiery server and click Connect.

   If you cannot locate your Fiery server, contact your administrator.
3. Type the user name and password in the SMB/CIFS File System Authentication dialog box.

   The “Guest” account can be used as the default. The Guest account does not require a password. If the Guest account cannot be used, ask your network administrator for an account.
4. Select the Mac_User_SW folder from the shared volume list and click OK.
5. Double-click the Fiery Printer Driver Installer icon to start installing the printer driver.

   Follow the on-screen instructions.
Uninstalling printer driver files

The Fiery Software Uninstaller utility is installed and used locally. You do not need to connect to the Fiery server before you use the software.

To install and use the Fiery Software Uninstaller utility

1. Copy Fiery Software Uninstaller.dmg to your desktop from the User Software DVD or the Mac_User_SW folder from the shared volume list on the Fiery server.

2. Double-click Fiery Software Uninstaller.dmg.

   The Fiery Software Uninstaller opens in the Finder, displaying the Fiery Software Uninstaller icon and an arrow pointing to a link to the Applications folder.

3. Drag the Fiery Software Uninstaller icon to the Applications folder.

4. Open the Applications folder and double-click the Fiery Software Uninstaller icon.

5. Click the Printers tab if it is not already selected.

6. Select a printer from the Installed Printers list and do one of the following:
   - Click Remove Printer and Driver to remove the printer along with its printer driver files.
     
     If you want to remove the printer and the associated printer driver files, you can select only one printer at a time.
   - Click Remove Printer to remove the printer from the Installed Printers list only, but leave the printer driver files installed.
     
     The utility can remove only printers that are not currently in use or open on the Dock.

   **NOTE:** If more than one printer uses a printer driver, removing the printer driver also removes all printers using that driver.

7. To confirm that you want to delete the printer, type the password for your Mac OS computer in the dialog box and click OK.

8. Click the Drivers tab to view the installed printer drivers.

9. Close the Fiery Software Uninstaller dialog box.

To delete the Fiery Software Uninstaller utility

- Delete the Fiery Software Uninstaller icon from the Applications folder.
Setting up Mac OS computers for printing

The following sections describe how to set up the Fiery server on a Mac OS computer.

<table>
<thead>
<tr>
<th>Procedure</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting up printing with Mac OS X v10.8</td>
<td>page 67</td>
</tr>
<tr>
<td>Setting up printing with Mac OS X v10.7</td>
<td>page 71</td>
</tr>
<tr>
<td>Setting up printing with Mac OS X v10.6.x</td>
<td>page 75</td>
</tr>
<tr>
<td>Setting up printing with Mac OS X v10.5.x</td>
<td>page 78</td>
</tr>
<tr>
<td>Adding a non-English printer on a Mac OS computer</td>
<td>page 81</td>
</tr>
<tr>
<td>Configuring installable options</td>
<td>page 81</td>
</tr>
<tr>
<td>Using Desktop Printer (optional)</td>
<td>page 81</td>
</tr>
</tbody>
</table>

Setting up printing with Mac OS X v10.8

Use the following procedure to set up the Fiery server on a computer running Mac OS X v10.8.

To set up the Fiery server from the Print dialog box

1. Open a file in your application.
2. Select Print from the File menu.
   
The Print dialog box appears.
3. Select Add Printer from the Printer menu.
   
In the dialog box that appears, select a printer connection. Use one of the printer connections in the following table to add a printer.

To set up the Fiery server with Print & Scan

1. Select System Preferences from the Apple menu, and then select Print & Scan.
   
The Print & Scan dialog box appears.
2. Click the “+” button to add a printer.
   
In the dialog box that appears, select a printer connection. Use one of the following connections to add a printer.

<table>
<thead>
<tr>
<th>Printing connection</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default (Bonjour)</td>
<td>page 68</td>
</tr>
<tr>
<td>IP Printer</td>
<td>page 70</td>
</tr>
</tbody>
</table>
To add a printer with the Default (Bonjour) connection

**Note**: Bonjour printer setup works only if the Fiery server and the Mac OS client computer are on the same TCP/IP subnet on the network. Bonjour must also be configured on the Fiery server.

1. Click the Default icon in the dialog box.

The names of printers with default connections are listed. The virtual printers that are configured at the Fiery server are also listed.

**Note**: The names of the virtual printers appear as **printer name:virtual printer name** in the Printer Name list.

**Note**: Any published virtual printer is available over LPR and FTP.

**Note**: SMB printing is not supported for Mac OS X v10.8.

2. Select the Fiery server from the list.

The information about the selected printer appears at the bottom of the Default pane. The appropriate printer driver file for the Fiery server is automatically selected. If your administrator configured the Secure Access printing at the Fiery server, the printer driver file for Secure Access printing is selected.

3. Click Add.

The Fiery server name appears in the list of printers.

4. Select Fiery server.

5. Click Options & Supplies, and then click the Driver tab.

6. Specify the installable option settings, and then click OK.

For information about configuring installable options, see printer driver Help.
NOTE: The following applies to the Bonjour connection using the Fiery server printer driver on Mac OS X v10.8.

To obtain the IP address of the Fiery server

1 Select System Preferences from the Apple menu, and then select Print & Scan.
2 Select the Fiery server from the list, and then click Options & Supplies.
3 Click the General tab, and then click Show Printer Webpage.
   The WebTools page for the Fiery server appears.
4 Click the Configure tab.
5 Scroll to Network Protocol Setup, locate the IP address for the Fiery server, and record it for future reference.
   The IP address is needed to turn on Two-Way Communication in the printer driver.
   For information about Two-Way Communication, see printer driver Help.
6 Click File > Close Window to close WebTools.
7 Click OK to close the Options & Supplies pane.
8 Close the Print & Scan dialog box.
To add a printer with the IP Printer connection

1. Click the IP icon in the dialog box.

![Image of Print & Scan dialog box](image)

2. LPD printing: Select Line Printer Daemon - LPD from the Protocol list, type the Fiery server IP address or DNS name in the Address field, and then type the print connection (print or hold) in the Queue field. Proceed to step 4.

   Port 9100 printing: Select HP Jetdirect - Socket from the Protocol list. Type the Fiery server IP address or DNS name in the Address field. The Queue field can be left empty. Proceed to step 4.

   IP printing: Select Internet Printing Protocol - IPP from the Protocol list and type the Fiery server IP address or DNS name in the Address field. Proceed to step 3.

   The IP address or DNS name appears in the Name field.

3. Type “ipp/” followed by the print connection (print, hold, direct, or name of virtual printer) in lowercase letters in the Queue field.

   **NOTE:** The Fiery server requires a queue name. Do not leave the Queue field empty.

4. Choose Select Printer Software from the Use menu.

5. Locate the color press manufacturer or model in the list, select the printer driver file, and then click OK.

6. Click Add.

   The installable options pane in the Print & Scan dialog box appears.

7. Specify the installable option settings, and then click OK.

   The Fiery server with its IP address appears in the list of printers.

   For information about configuring installable options, see printer driver Help.
Setting up printing with Mac OS X v10.7

Use the following procedure to set up the Fiery server on a computer running Mac OS X v10.7.

**To set up the Fiery server from the Print dialog box**

1. Open a file in your application.
2. Select Print from the File menu.
   
   The Print dialog box appears.
3. Select Add Printer from the Printer menu.
   
   In the dialog box that appears, select a printer connection. Use one of the printer connections in the following table to add a printer.

---

**To set up the Fiery server with Print & Scan**

1. Select System Preferences from the Apple menu, and then select Print & Scan.
   
   The Print & Scan dialog box appears.
2. Click the “+” button to add a printer.
   
   In the dialog box that appears, select a printer connection. Use one of the following connections to add a printer.

<table>
<thead>
<tr>
<th>Printing connection</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default (Bonjour)</td>
<td>page 68</td>
</tr>
<tr>
<td>IP Printer</td>
<td>page 70</td>
</tr>
</tbody>
</table>
**To add a printer with the Default (Bonjour) connection**

**Note:** Bonjour printer setup works only if the Fiery server and the Mac OS client computer are on the same TCP/IP subnet on the network. Bonjour must also be configured on the Fiery server.

1. Click the Default icon in the dialog box.

![Add Printer Interface](image)

The names of printers with default connections are listed. The virtual printers that are configured at the Fiery server are also listed.

**Note:** The names of the virtual printers appear as `printer name:virtual printer name` in the Printer Name list.

**Note:** Any published virtual printer is available over LPR and FTP.

**Note:** SMB printing is not supported for Mac OS X v10.7.

2. Select the Fiery server from the list.

The information about the selected printer appears at the bottom of the Default pane. The appropriate printer driver file for the Fiery server is automatically selected. If your administrator configured the Secure Access printing at the Fiery server, the printer driver file for Secure Access printing is selected.

3. Click Add.

The Fiery server name appears in the list of printers.

4. Select Fiery server.

5. Click Options & Supplies, and then click the Driver tab.

6. Specify the installable option settings, and then click OK.

For information about configuring installable options, see printer driver Help.
NOTE: The following applies to the Bonjour connection using the Fiery server printer driver on Mac OS X v10.7.

To obtain the IP address of the Fiery server
1. Select the Apple menu > System Preferences > Print & Scan.
2. Select the Fiery server from the list and then click Options & Supplies.
3. Click the General tab, and then click Show Printer Webpage.
   The WebTools page for the Fiery server appears.
4. Click the Configure tab.
5. Scroll to Network Protocol Setup, locate the IP address for the Fiery server, and record it for future reference.
   The IP address is needed to turn on Two-Way Communication in the printer driver.
   For information about Two-Way Communication, see printer driver Help.
6. Click File > Close Window to close WebTools.
7. Click OK to close the Options & Supplies pane.
8. Close the Print & Scan dialog box.
To add a printer with the IP Printer connection

1. Click the IP icon in the dialog box.

2. LPD printing: Select Line Printer Daemon - LPD from the Protocol list, type the Fiery server IP address or DNS name in the Address field, and then type the print connection (print or hold) in the Queue field. Proceed to step 4.

   Port 9100 printing: Select HP Jetdirect - Socket from the Protocol list. Type the Fiery server IP address or DNS name in the Address field. The Queue field can be left empty. Proceed to step 4.

   IP printing: Select Internet Printing Protocol - IPP from the Protocol list and type the Fiery server IP address or DNS name in the Address field. Proceed to step 3.

   The IP address or DNS name appears in the Name field.

3. Type “ipp/” followed by the print connection (print, hold, direct, or name of virtual printer) in lowercase letters in the Queue field.

   NOTE: The Fiery server requires a queue name. Do not leave the Queue field empty.

4. Choose Select Printer Software from the Print Using menu.

5. Locate the color press manufacturer or model in the list, select the printer driver file, and then click OK.

6. Click Add.

   The installable options pane in the Print & Scan dialog box appears.

7. Click OK.

   The Fiery server with its IP address appears in the list of printers.

8. Select Fiery server.
9 Click Options & Supplies, and then click the Driver tab.

10 Specify the installable option settings, and then click OK.

For information about configuring installable options, see printer driver Help.

**Setting up printing with Mac OS X v10.6.x**

Use the following procedures to set up the Fiery server on a computer with Mac OS X v10.6.x.

---

**TO SET UP THE FIERY SERVER FROM THE PRINT DIALOG BOX**

1 Open a file in your application.

2 Select Print from the File menu.

The Print dialog box appears.

3 Select Add Printer from the Printer menu.

In the dialog box that appears, select a printer connection. Use one of the printer connections in the following table to add a printer.

---

**TO SET UP THE FIERY SERVER WITH PRINT & FAX**

1 Select System Preferences from the Apple menu, and then select Print & Fax.

The Print & Fax dialog box appears.

2 Click the “+” button to add a printer.

In the dialog box that appears, select a printer connection. Use one of the following connections to add a printer.

<table>
<thead>
<tr>
<th>Printing connection</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default (Bonjour)</td>
<td>page 76</td>
</tr>
<tr>
<td>IP Printer</td>
<td>page 77</td>
</tr>
</tbody>
</table>
To add a printer with the Default (Bonjour) connection

**Note:** Bonjour printer setup works only if the Fiery server and the Mac OS client computer are on the same TCP/IP subnet on the network. Bonjour must also be configured on the Fiery server.

1. Click the Default icon in the dialog box.

![Add Printer dialog box](image)

The names of printers with default connections are listed. The virtual printers that are configured at the Fiery server are also listed.

**Note:** The names of the virtual printers appear as *printer name: virtual printer name* in the Printer Name list.

**Note:** Any published virtual printer is available over SMB, LPR, and FTP.

2. Select the Fiery server from the list.

The information about the selected printer appears at the bottom of the Default pane. The appropriate printer driver file for the Fiery server is automatically selected. If your administrator configured the Secure Access printing at the Fiery server, the printer driver file for Secure Access printing is selected.

3. Click Add.

The Installable Options pane in the Print & Fax dialog box appears.

4. Click Continue.

The Fiery server name appears in the list of printers.

5. Select Fiery server.

6. Click Options & Supplies, and then click the Driver tab.

7. Specify the installable option settings, and then click OK.

For information about configuring installable options, see printer driver Help.
To add a printer with the IP Printer connection

1. Click the IP icon in the dialog box.

![Add Printer dialog box]

2. LPD printing: Select Line Printer Daemon - LPD from the Protocol list, type the Fiery server IP address or DNS name in the Address field, and then type the print connection (print or hold) in the Queue field. Proceed to step 4.

   Port 9100 printing: Select HP Jetdirect - Socket from the Protocol list, type the Fiery server IP address or DNS name in the Address field. The Queue field can be left empty. Proceed to step 4.

   IP printing: Select Internet Printing Protocol - IPP from the Protocol list and type the Fiery server IP address or DNS name in the Address field. Proceed to step 3.

   The IP address or DNS name appears in the Name field.

3. Type “ipp/” followed by the print connection (print, hold, direct, or name of virtual printer) in lowercase letters in the Queue field.

   **NOTE:** The Fiery server requires a queue name. Do not leave the Queue field empty.

4. Choose Select Printer Software from the Print Using menu.

5. Locate the color press manufacturer or model in the list, select the printer driver file, and then click OK.

6. Click Add.

   The Installable Options pane in the Print & Fax dialog box appears.

7. Click Continue.

   The Fiery server with its IP address appears in the list of printers.

8. Select Fiery server.
9 Click Options & Supplies, and then click the Driver tab.

10 Specify the installable option settings, and then click OK.

For information about configuring installable options, see printer driver Help.

### Setting up printing with Mac OS X v10.5.x

Use the following procedures to set up the Fiery server on a computer with Mac OS X v10.5.x.

#### TO SET UP THE FIERY SERVER FROM THE PRINT DIALOG BOX

1. Open a file in your application.

2. Select Print from the File menu.

   The Print dialog box appears.

3. Select Add Printer from the Printer menu.

   In the dialog box that appears, select a printer connection. Use one of the printer connections in the following table to add a printer.

#### TO SET UP THE FIERY SERVER WITH PRINT & FAX

1. Select System Preferences from the Apple menu, and then select Print & Fax.

   The Print & Fax dialog box appears.

2. Click the “+” button to add a printer.

   In the dialog box that appears, select a printer connection. Use one of the following connections to add a printer.

<table>
<thead>
<tr>
<th>Printing connection</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default (Bonjour)</td>
<td>page 79</td>
</tr>
<tr>
<td>IP Printer</td>
<td>page 80</td>
</tr>
</tbody>
</table>
**To add a printer with the Default (Bonjour) connection**

**Note:** Bonjour printer setup works only if the Fiery server is on the same local area network (LAN) as the Mac OS client computer. Bonjour must also be configured on the Fiery server.

1. Click the Default icon in the dialog box.

![Image of Default icon dialog box]

The names of printers with default connections are listed. The virtual printers that are configured at the Fiery server are also listed.

**Note:** The names of the virtual printers appear as `printer name: virtual printer name` in the Printer Name list.

**Note:** Any published virtual printer is available over SMB, LPR, and FTP.

2. Select the Fiery server from the list.

   The information about the selected printer appears at the bottom of the Default pane. The appropriate printer driver file for the Fiery server is automatically selected.

3. Click Add.

   The Installable Options pane in the Print & Fax dialog box appears.

4. Click Continue.

   The Fiery server name appears in the list of printers.

5. Select Fiery server.

6. Click Options & Supplies, and then click the Driver tab.

7. Specify the installable option settings, and then click OK.
**To add a printer with the IP Printer connection**

1. Click the IP icon in the dialog box.

2. **LPD printing**: Select Line Printer Daemon - LPD from the Protocol list, type the Fiery server IP address or DNS name in the Address field, and then type the print connection (print or hold) in the Queue field. Proceed to step 4.

   **Port 9100 printing**: Select HP Jetdirect - Socket from the Protocol list, type the Fiery server IP address or DNS name in the Address field. The Queue field can be left empty. Proceed to step 4.

   **IP printing**: Select Internet Printing Protocol - IPP from the Protocol list and type the Fiery server IP address or DNS name in the Address field. Proceed to step 3.

   The IP address or DNS name appears in the Name field.

3. Type “ipp/” followed by the print connection (print, hold, direct, or name of virtual printer) in lowercase letters in the Queue field.

   **NOTE**: The Fiery server requires a queue name. Do not leave the Queue field empty.

4. Choose Select a driver to use from the Print Using menu.

5. Locate the color press manufacturer or model in the list, and select the printer driver file.

6. Click Add.

   The Installable Options pane in the Print & Fax dialog box appears.

7. Click Continue.

   The Fiery server with its IP address appears in the list of printers.
8 Select Fiery server.
9 Click Options & Supplies, and then click the Driver tab.
10 Specify the installable option settings, and then click OK.
   
   For information about configuring installable options, see printer driver Help.

Adding a non-English printer on a Mac OS computer

When adding a non-English Fiery server printer on Mac OS computer, you must navigate to Other to select the correct printer driver for your language.

To ADD A NON-ENGLISH PRINTER

1 Open the Add Printer dialog box.
   The list of available Bonjour printers is displayed.
2 Select the Fiery server from the list.
3 Select Other from the Print Using menu.
4 On your computer, navigate to Library > Printers > PPDs > Contents > Resources, and open the language folder that corresponds to the language that you are using on your system.
5 Select the Fiery server from the list.
6 Click Open, and then click Add.

Configuring installable options

To use the print options for the color press and Fiery server appropriately, you must configure the Fiery server from your computer for the options that are installed on the color press. Configure the options manually.

For information about configuring installable options, see printer driver Help.

Using Desktop Printer (optional)

After adding the Fiery server to the list of printers in the Print & Fax (or Print & Scan) dialog box or the Printer Setup Utility, you can create and use the Desktop Printer feature.

For information about the Desktop Printer feature, see printer driver Help.
Printing from Mac OS computers

You can print to the Fiery server just as you would print to any other printer from a Mac OS application. Select the Fiery server as the current printer in the list of printers, specify print options, and then print the document from the application.

The following table includes other methods to print to the Fiery server and describes where to find information about these features.

<table>
<thead>
<tr>
<th>For more information</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Downloading files to the Fiery server with the Docs WebTool</td>
<td>Utilities</td>
</tr>
<tr>
<td>Printing documents using Hot Folders</td>
<td>Utilities</td>
</tr>
<tr>
<td>Printing documents using Command WorkStation</td>
<td>Utilities</td>
</tr>
<tr>
<td>Achieving optimal printing results from applications</td>
<td>Color Printing and Fiery Color Reference</td>
</tr>
<tr>
<td>Selecting the Fiery server in the Printers list</td>
<td>page 83</td>
</tr>
<tr>
<td>Setting print options and printing from Mac OS applications</td>
<td>page 84</td>
</tr>
<tr>
<td>Customizing the Quick Access view</td>
<td>page 87</td>
</tr>
<tr>
<td>Viewing the color press status</td>
<td>page 87</td>
</tr>
<tr>
<td>Defining and printing custom page sizes</td>
<td>page 137</td>
</tr>
</tbody>
</table>
Selecting the Fiery server in the Printers list

Before you print a job, you must select the Fiery server in the Printers list. Use the following procedure to select the Fiery server as your default printer.

**NOTE:** The following procedure uses Mac OS X v10.6 illustrations.

To select the Fiery server as the default printer with Mac OS X

1. Make sure that the Fiery server is connected to the network and turned on.
2. Select System Preferences from the Apple menu, and then select Print & Fax (or Print & Scan).

![Print & Fax window](image)

The printers that are set up for printing are listed. The virtual printers that are configured at the Fiery server and set up for printing are also listed.

3. To make the Fiery server the default printer, select it from the Default Printer menu.
4. Close the window.

**NOTE:** When the printer driver establishes communication with the Fiery server on Mac OS X v10.7 and v10.8, the queries are listed as jobs in the Print Queue. To open the Print Queue, select the Apple menu > System Preferences > Print & Scan, then select the Fiery server from the list of printers, and click Open Print Queue. The queries are not real jobs and they will disappear from the Print Queue after they are completed.
Setting print options and printing from Mac OS applications

To print from Mac OS client computers, install the printer driver files. For instructions, see “Installing Mac OS printer driver files” on page 63. In Mac OS applications, print options are set from the Print dialog box.

Some print options that are selectable from an application are similar to print options that are specific to the Fiery server and the color press. In these cases, use the print options specific to the Fiery server and the color press. These options appear in the Fiery Features pane and/or in the Printing Preferences window. The application may not set up the file properly for printing on the Fiery server, resulting in unexpected finishing, printing errors, or longer processing time.

If you specify incompatible print settings when printing a document, the Conflict dialog box provides instructions to resolve the conflict.

Some print options, such as expert color settings, are available only if Two-Way Communication is turned on or a particular installable option is configured. For information about Two-Way Communication, see printer driver Help. For information about configuring installable options, see page 81.

If you select Printer’s default, the job prints according to the settings that the administrator specified in Setup. For more information, see page 105.

The following procedure explains how to use the printer driver to specify print options for a particular job and print it to the Fiery server. For information about print options, see page 104.

**NOTE:** The following procedure uses Mac OS X v10.6 illustrations.
To set print options and print from Mac OS X

1. In your application, select File > Print, and select the Fiery server as your printer.
2. Select Fiery Features from the drop-down list.

When you save the print options in a preset, the following option settings are not reflected:

- **Job Info options:** Schedule printing, Secure print, User Authentication password, Account ID, User ID, and Password
- **Layout option:** Impose

For information about using presets, see printer driver Help.

**NOTE:** You cannot import or export Local Presets from or to the Mac OS X v10.7 and v10.8 printer drivers.

**NOTE:** For a list of print options, see page 106.
3 Click Full Properties in the Quick Access pane to specify print options and settings for your job.

The print options are grouped by categories. Each group or tab contains print options that are similar or complement one another.

The groups or tabs are as follows:

**Quick Access** contains duplicate print options from the other job properties groups. It is customizable, so any Job Override print option can be added or removed from the view. The Quick Access pane lets you find print options quickly without browsing through all of the Job Properties tabs. For information about customizing the Quick Access pane, see page 87.

**Job Info** contains all information about the job, including user information that may be required for user authentication, secure print properties, job handling, and document server. For information about Job Info options, see page 107.

**Media** contains attributes and sources of paper to print and insert. For information about Media options, see page 110.

**Layout** defines how the file is positioned or imaged on the media/sheet, except for positioning that compensates for finishing options, for example, Tray Alignment. For information about Layout options, see page 113.

**Color** contains color settings and graphic arts features (when activated). For information about Color options, see page 118.

**Image** contains all Image Quality settings supported by the connected Fiery server and color press. For information about Image options, see page 122.

**Finishing** contains print options that are specific to the Fiery server and to the finishing equipment on the color press. These options override settings in Fiery server Printer Setup but can be changed from Command WorkStation. For information about Finishing options, see page 124.

**VDP** contains all variable data printing (VDP) settings, such as FreeForm and advanced VDP settings. For information about VDP options, see page 126.

**Stamping** contains image stamping options that adds or hides/removes an image on the job. This also includes watermark properties that define the placement and style of the watermark. For information about Stamping/Watermark options, see page 128 or printer driver Help.

**Printer** contains color press status that includes the current paper and toner levels. For more information, see page 87 or printer driver Help.

4 After you specify the print settings, click Print to send your print job.
Customizing the Quick Access pane

The Quick Access pane can be customized with print options that you use frequently. This saves time because you do not have to open all of the other print option icons to set the options that you placed in Quick Access.

When you place a print option in Quick Access, it still appears under its original print option icon. You can set the option from either location.

To customize Quick Access

1. In your application, select File > Print and select the Fiery server as your printer.
2. Select Fiery Features from the drop-down list.
3. Click Customize to specify the options shown in the Quick Access pane.

You can select a shortcut from the Available Shortcuts list and add it to the Current Shortcuts list, as well as remove a shortcut from the Current Shortcuts list. Click OK to save your changes.

NOTE: The Configure button for Two-Way Communication is not displayed in the Mac OS X v10.7 and v10.8 printer drivers.

For more information about Quick Access, see printer driver Help.

Viewing the color press status

If your color press is connected to a TCP/IP network, you can retrieve the color press status, levels of consumable materials, and color settings, from the Fiery server and display them in the printer driver with the Two-Way Communication option.

For information about monitoring the color press status, see printer driver Help.
Printing Methods

In addition to printing jobs from the Fiery server printer driver, you can print jobs using these methods:

- **E-mail Service** submits jobs to the Fiery server as email attachments. For more information, see page 88.
- **USB flash drive** prints saved files to the Fiery server. For more information, see page 92.
- **FTP printing** prints to the Fiery server using the FTP protocol. For more information, see page 94.
- **Secure printing** requires that a password be entered at the Fiery server before a job is printed. For more information, see page 95.
- **Sample printing** prints sample pages from a long job to ensure print quality. For more information, see page 96.
- **Adobe PDF Print Engine (APPE)** is an additional interpreter that allows native PDF processing and rendering without the need for the Fiery server to convert the job from PDF to PostScript. For more information, see page 98.
- **PrintMe cloud printing** downloads and prints a document to the color press using the color press touch panel, see page 100.
- **Web Services for Devices (WSD)** allows printing from Windows 7 and Windows 8 computers, see page 103.

E-mail Service

E-mail Service allows you to control the Fiery server using your current email infrastructure, print to remote locations, and bypass firewalls. E-mail Service is not application-specific. You can use any email infrastructure.

The Fiery server supports internal address books. Administrators can retrieve, add, delete, and clear addresses from address books by sending requests through email. For more information about address books, see Configuration and Setup.

To set up E-mail Service, see Configure Help.
Use E-mail Service in the following ways:

- Print a job from an email application.

  To print with an email client, you send a file as an email attachment. E-mail Service extracts the file and sends it to the Fiery server. The attachment can be in any file format the Fiery server recognizes (PS, PDF, EPS, VDP, or TIFF).

**NOTE:** E-mail Service does not process files with .vbs, .exe, or .bat extensions.

- Manage jobs using an email application.

  You can manage your print jobs by submitting email commands to the Fiery server using email.

- **Scan to E-mail.**

  You can scan a document and send it to an email address as an attachment or URL. For more information about Scan to E-mail, see *Utilities*.

**Printing using an email client**

You can submit print jobs to the Fiery server in the form of an email attachment using your email application. When you send an email with an attachment, E-mail Service extracts the file and sends it to the Fiery server Print queue. The file format must be one supported by the Fiery server.

By default, anyone can print with an email client, unless the Print address book has been set up by the administrator. If the Print address book has been set up and your email address is not in it, you cannot send files to the Fiery server using email. For more information about address books, see *Configuration and Setup*.

When User Authentication is turned on at the Fiery server, the email attachment must have the appropriate user name and password when it is printed through email printing. As part of creating the email attachment with the Fiery server printer driver, type the appropriate user name and password on the Job Info tab of the printer driver. The user name and password must match those defined by the administrator in the Users and Groups section of Configure. For information about Users and Groups, see Configure Help.

**NOTE:** The Direct connection is not supported by the email client feature.

**NOTE:** When the attached job is printed, the email is also printed, which includes the typical header information, such as subject, date, sender, and so forth.

**NOTE:** The following illustrations depict the Microsoft Outlook email application.
TO PRINT USING AN EMAIL CLIENT

1 Open your email application.
2 Type the Fiery server email address in the To: line.
3 Type text in the Subject line or leave the Subject line blank.
4 Attach the file that you want to print.

The attachment can be in any file format the Fiery server recognizes (PS, PDF, EPS, VDP, or TIFF).

**NOTE:** If your attachment exceeds the file size limitation set by your email system administrator, the email is not sent.

5 To identify the job or provide further processing instructions, type text in the body of the message.

**NOTE:** HTML-formatted email messages are not supported, and might not print as they appear on the remote workstation. Send email messages in plain text format.

6 Send the email.

The file is sent to the Fiery server and the job is printed. After the Fiery server receives the job, you receive an email notification that the print job was accepted. The email provides a job identification (ID). Use job IDs to manage jobs with email commands (see “Managing print jobs with email commands” on page 91). The email notification indicates any current error at the color press.

After the job is printed, you receive a second email notification that indicates the job printed successfully.
Managing print jobs with email commands

You can manage your print jobs by submitting commands to the Fiery server using email. You can cancel a job, check job status, and get help on a job. When you send a command, the Fiery server sends an email response.

**To manage print jobs with email commands**

1. In your email application, type the Fiery server email address in the To: line.
2. Type one of the following commands in the Subject line:
   - To check the status of a job, type #JobStatus<job id> in the Subject line.
     You receive a reply to your job status query. You can only get the status of the job if you sent the job or are an administrator.
   - To cancel a job, type #CancelJob<job id> in the Subject line.
     You receive a notification indicating that the job has been canceled and did not print to the Fiery server. You can only cancel a job if you sent the job.
   - To get help, type #Help in the Subject line.
     You receive an email response that contains links that allow you to cancel jobs, check job status, and search and manage address books. Click any of the links to perform a command.
3. Send the email to the Fiery server.
Printing from a USB flash drive

You can print files on a USB flash drive to the Fiery server. To do so, save PS, PCL, EPS, TIFF, and PDF files to the USB flash drive and download them directly to the Fiery server. You can print files that originated on Mac OS X or Windows computers.

You can print files automatically from a USB flash drive to one of the standard print queues on the Fiery server (Print, Hold, or Direct) or to published virtual printers (if supported). Verify with your administrator that these connections are published in Setup.

Or you can print any of the files on your USB flash drive, specify where to send them, and also select some print options.

For more information about virtual printers, see Command WorkStation Help.

Before you print files from a USB flash drive, ask your administrator to configure the appropriate options. For more information about configuring the appropriate options, see Configuration and Setup or Configure Help.

The two methods of printing files from a USB flash drive are automatic printing and manual printing.

Automatic printing

To print automatically to Print, Hold, or Direct queues, or to published virtual printers with the Print All setting, set up folders on your USB flash drive with the names print, hold, direct, and the names of any published virtual printers. When you plug the USB flash drive into a USB port on the Fiery server, the files in those folders are sent automatically to the corresponding queues.

To print files from the USB flash drive

1. Configure the USB print options in Setup.
2. Create folders at the top (root) level of the USB flash drive named print, hold, direct, and virtual printer.
3. Save the files (PS, EPS, PCL, TIFF, or PDF) from the user’s computer to the USB flash drive.
   
   Files copied to the print, hold, direct, or virtual printer folders are downloaded to the corresponding print connection on the Fiery server automatically when you connect the USB flash drive to the Fiery server. Files copied to the root level of the USB flash drive are downloaded to the Print queue.

4. Remove the USB flash drive from the computer and connect it to the USB connector on the Fiery server.

   Make sure that the USB flash drive is properly stopped before you disconnect it from the computer.

   For the location of the USB port, see Configuration and Setup.
Manual printing

When USB Media Autoprint is disabled in Server Setup, you must manually select the files that you want to print from the USB flash drive and specify where you want to send them.

**To print using USB Media Server**

1. Insert the USB flash drive into a USB port on the Fiery server.
2. Press Services Home button on the color press touch panel.
3. Press the Fiery icon.
4. Press the USB tab to view the USB Media Server browsing window. The files on the USB flash drive are displayed on the color press touch panel. Both files at the root level of the USB flash drive and folders are displayed.
5. Press the Browse icon to go down a directory.
6. To browse back to the root level, press Upper Folder button located in the upper-right corner of the USB tab window.
7. To navigate through the list of files and folders, you can press the First icon, Prev icon, Next icon, or Last icon.
8. Print one file or all files in the directory.
   - To print one file, press the Print icon next to a file, and proceed to step 9.
   - To print all files in the directory, press Print All located in the upper-right corner of the USB tab window.
   The print options you can choose are:
   - Queue (Print, Direct, Hold or any published virtual printer set up for the Fiery server)
   - Copies (number of copies)
   - Duplex (Default, Off, Top-top, Top-bottom)
   - Paper size (Default, list of page sizes)
10. Press Print to send the file to the Fiery server for printing or Cancel to cancel the print request.
11. Press Services Home button on the color press touch panel.
12. Remove the USB flash drive from the Fiery server.
FTP printing

If FTP Services is configured on the Fiery server, the Fiery server is set up as an FTP server. You can send jobs to the Fiery server using FTP printing. For more information about configuring FTP Services, see Configure Help.

You can use any FTP client application. Before you use FTP printing, the FTP client application requires the following information (see your administrator):

- IP address or DNS name for the Fiery server
- Directory or path to send the job to, such as the Print queue, Hold queue, or published virtual printers (if supported)

**NOTE:** You cannot print to the Direct connection with FTP printing.

- User name and password (if required)

You can send the following files to the Fiery server:

- PostScript (PS)
- Printer Control Language (PCL)
- Tagged Image File Format (TIFF)
- Portable Document Format (PDF)

**NOTE:** Encapsulated PostScript (EPS) files are not supported for FTP printing.

**To print files to the Fiery server with the FTP protocol**

1. Connect to the Fiery server with your FTP client application.

   Folders corresponding to the Print queue, Hold queue, and any published virtual printers are displayed.

2. Navigate to the folder representing the print connection or published virtual printer.

3. Upload your job to the appropriate folder.

   After the job is printed, it is deleted from the Fiery server.
Printing and retrieving a secure print job

The Secure Print feature offers a level of security for confidential or sensitive print jobs, which print only when you are present at the color press. To use this feature, you first enter an arbitrary password into the Secure print field in the printer driver when you send your job to the Fiery server. To print your job, you re-enter the password at the color press touch panel as described in the following procedures.

To send a secure print job

1. In your application, select File > Print, select the Fiery server as your printer, and do one of the following:
   - Windows: Click Properties, and then click the Job Info icon.
   - Mac OS X: Select Fiery Features from the drop-down list, click Full Properties in the Quick Access pane, and then click the Job Info icon in the Printing Preferences dialog box.
2. Type an arbitrary password in the Secure print field.
   
   **NOTE:** The 31-digit password is limited to alphanumeric characters (do not use symbols).
   For more information about typing the password, see page 108.
3. Make any other required changes to Job Properties and send your job to the Fiery server.
4. Click OK to close the Fiery server Properties dialog box.
5. Click OK or Print to close the Print dialog box.

   The job is sent to the color press.

To retrieve a secure print job from the color press

1. On the color press touch panel, press the Services Home button.
2. Press the Fiery icon.
3. Press the Jobs tab.
4. Press the Secure tab.
5. On the Password screen, touch the Password field, and a keyboard appears.
6. Type the same password that you typed in the Secure Print field of the printer driver, and then press Enter.

   The print jobs that match the password are displayed in the login window.
7. Select your print job and choose Print or Delete.

   After 45 seconds of inactivity, the Secure screen returns to the main Jobs screen.
Sample printing

The Sample Print feature allows you to print extra pages to an easily accessible output tray during a long print job, to verify that the color press is performing as expected.

Sample Print should only be used with a color press that has multiple output trays, and is useful when one of the output trays is closed and not easily accessed during printing.

For example, when a job is currently printing to a closed elevator (such as 1,000 pages to an output tray that cannot be opened until the entire job is completed), you can use Sample Print to print a separate page or finished output set to an open output tray, to verify the output. If the output is unsatisfactory, you can take corrective action.

The Sample Print default settings for a specified Fiery server are set up in WebTools Configure. For more information, see Configure Help.

When the job is printing, you can initiate a sample print from Command WorkStation. For more information about Sample Print, see Command WorkStation Help.

Using Sample Print

You can print an extra sheet or output set as follows:

- On-demand during the printing of a job
- Every N-sheets during the currently printing job
- Every N-sheets until cancelled (can span jobs)

When the job is printing, you can initiate a sample print. The default Setup values are applied and any existing sample print command in progress is overridden.

If Start Sample Print appears dimmed, the Fiery server is already performing a sample print or is not available for the specified Fiery server.

To initiate a sample print

- While a job is printing, initiate a sample print from Server > Start Sample Print.

After Sample Print is initiated, the Fiery server performs the sample print based on the options specified in Configure.

To cancel a sample print

- While a job is printing, cancel a sample print from Server > Stop Sample Print.

The Fiery server cancels the previously requested sample print.
Customizing the Command WorkStation toolbar

The Job Center toolbar can be customized to show the Sample Print toolbar icon.

To customize the Command WorkStation toolbar

1. Right-click anywhere on the toolbar, and select Customize from the submenu that appears.
2. Add the Start Sample Print icon by dragging it to the toolbar.
3. Specify how the toolbar icons should be shown: Icons or Icons and Text.
4. Select the Use Small Icons check box to show smaller toolbar icons.
5. Click Done when you are finished.
Adobe PDF Print Engine (APPE)

The Fiery server provides features of the Adobe PDF Print Engine (APPE), which is an additional interpreter that allows native PDF processing and rendering without requiring the Fiery server to convert the job from PDF to PostScript. No special printer driver is required for printing APPE jobs, but the administrator must turn on related settings in Setup. If APPE is not turned on, PDF files are processed with the PostScript interpreter of the Fiery server. All PostScript files continue to be processed with the PostScript interpreter.

The APPE option is not available from the printer driver, but is included in Job Properties in Command WorkStation. After the administrator turns on APPE as the default in Configure, you can turn on or turn off the APPE option in Job Properties on a per-job basis.

**NOTE:** Integrated Fiery Color Server does not support the APPE option.

To turn on the APPE workflow in the Fiery server, see *Configuration and Setup*.

Printing with the APPE workflow

You can print with the APPE workflow using one of the following methods:

- **Command WorkStation**
  - Import a job, or drag a job from your computer to the Job Center of Command WorkStation.
  
  For information about using Command WorkStation, see Command WorkStation Help.

- **Hot Folders**
  - Configure a hot folder for APPE.
  
  For information about using Hot Folders, see Hot Folders Help.

---

**USING APPE WORKFLOW IN COMMAND WORKSTATION**

1. Double-click a PDF job in the Held or Printed list, or select the job and do one of the following:
   - Right-click to select Properties.
   - Select Job Center > Properties.
   - Select Properties from the Actions menu.

   For information about printing multiple files, see “Printing multiple files with APPE” on page 99.
2 Select the Adobe PDF Print Engine Preferred check box.

3 Specify the print option settings, and then click Print.

**Printing multiple files with APPE**

If you open Job Properties for files of different file types, the Adobe PDF Print Engine Preferred option is displayed only if one of the selected files is a PDF. The print option name is shown as Adobe PDF Print Engine Preferred (Applies only to PDF jobs) and the check box indicates at least one of the PDF jobs selected has been processed through the APPE workflow.

For a multiple file selection containing non-PDF files, the Adobe PDF Print Engine Preferred option is not shown.

If a PDF file contains mixed page sizes when processed using APPE, the Paper Size option reflects the size of the first page in the PDF. If you override the size in Job Properties, all of the pages in the PDF become the selected size.

**TO ACCESS THE PROPERTIES OF MULTIPLE JOBS**

1 Shift-click to select multiple, sequential jobs, or Ctrl-click to select multiple, non-sequential jobs, and then click Properties.

   The Job Properties dialog box appears. Menus for each available print option are displayed.

2 After the multiple jobs have opened, specifying a value in the Job Properties dialog box applies it to all jobs.

   The Summary tab allows a side-by-side comparison of the Job Properties for multiple jobs.
PrintMe cloud printing

Users with a PrintMe subscription can upload a document to the PrintMe cloud service and then print the document to the color press using the color press touch panel.

In particular, observe the following:

- The PrintMe feature on the Fiery server requires a subscription to the PrintMe cloud service.
- Communication guaranteed only between EFI PrintMe cloud service and the Fiery server.
- Contact Electronics For Imaging for PrintMe cloud service issues or send an e-mail to PrintMe support at printmesupport@efi.com.
- PrintMe availability may vary, depending on the country or region.

Before you print

- Make sure that the Fiery server has an Internet connection and is connected to the network.
- Turn on PrintMe and related settings on the Fiery server using Configure.
  For information about configuring the settings in Setup on the Fiery server, see Configuration and Setup.
- Upload the document to PrintMe, either at www.printme.com or sent by email to print@printme.com.
  For more information about using PrintMe, see www.efi.com/fiery/Products/EFI PrintMe.
- Print directly from a Windows application. To do this, you must first install the PrintMe printer driver. For more information, see “Installing the PrintMe printer driver” on page 101.
- When you upload or email a document to PrintMe, you receive an email confirmation that contains a unique document ID. You need this document ID to print, as described in the following procedures.
- Make sure that the color press is not printing or processing any files.
- PrintMe supports the following file types: PDF, XLS, DOC, PPT, GIF, JPG, TIFF, PICT, HTML, TXT, and PS. The maximum file size is 25MB.
To print a document from the color press

1 On the color press touch panel, press the Services Home button.

2 Press the PrintMe icon.

3 Type the Document ID and press Next.
   Refer to the email confirmation for Document ID.
   Jobs associated with the password are displayed.
   Press the Learn About Document ID button to learn how to upload documents to the
   PrintMe cloud service.

4 Select a job to print and then press Print Options.
   The following options are provided:
   • **Copies**: Use the keypad on the color press touch panel to type a number.
   • **Duplex**: Select One Side, Duplex (duplex flip left) or Tumble (duplex flip up).
   • **Color mode**: Select Color or B/W (black-and-white)

5 Press Print to print the job.
   The job is sent to the color press.

6 Press Delete From PrintMe or Exit.
   Press Delete From PrintMe to permanently remove all documents associated with the
   Document ID from PrintMe.
   Press Exit to return to the Home screen on the color press.

Installing the PrintMe printer driver

After installing the PrintMe printer driver, you can print to the PrintMe cloud service just as
you would print to any desktop printer.

**NOTE:** The PrintMe printer driver is supported on client Windows computers that operate in
a non-proxy network environment.

The following procedure describes how to install the PrintMe universal printer driver for
Windows XP.
To install the PrintMe printer driver

1. Go to www.PrintMe.com/home/ and click Get the driver from the PrintMe toolbar to download the PrintMe printer driver.
2. Double-click the EFI PrintMe Driver icon and follow the on-screen instructions.
3. If prompted, restart the computer.
4. To verify that the driver is set up correctly, click Start and select Printers and Faxes.

   The EFI PrintMe printer should be listed. If it is not, reinstall the printer driver.

After the PrintMe printer driver is installed, you can print to the PrintMe cloud service from most Windows applications.

**NOTE:** To uninstall the PrintMe printer driver, open the Add/Remove Programs tool in the Windows Control Panel and remove the EFI PrintMe Driver.

To print documents from Windows applications

1. In the Windows application, click File > Print.
2. Select EFI PrintMe from the printer pull-down menu.
3. Enter your email address and click OK.

   An email message containing the Document ID is sent to your email address.
Web Services for Devices printing

Web Services for Devices (WSD) allows printing from Windows 7 and Windows 8 computers, and Windows 8-based tablets. The Fiery server must have the WSD option turned on in Setup. After Setup is complete, you can install the WSD printer driver for the Fiery server.

For information about configuring the settings in Setup on the Fiery server, see Configuration and Setup.

To install the WSD printer driver

1. Download the WSD printer driver with WebTools.

   For instructions on downloading the WSD printer driver with WebTools, see “Downloading printer drivers with WebTools” on page 13 or page 40.

2. In the Fiery Driver Installer dialog box, select the printer driver language and click Next.

   The Fiery Driver Installer installation wizard appears.

3. Click Next to install the Fiery Driver Installer on your computer.

4. Click Next in the Welcome to the InstallShield Wizard for Fiery Driver Installer dialog box.

5. Read the license agreement, click “I accept the terms of the license agreement” and click Next.

6. Select Add a network, wireless or Bluetooth printer.

7. Select the printer from the list of available printers and proceed to step 11.

   **Note:** The WSD printer shows the Fiery server with the printer in parentheses for the name of the printer.

   **If the printer is not listed, proceed to step 8.**

8. Click The printer that I want isn’t listed.

9. Click Add a printer using TCP/IP address or host name and click Next.

10. Select Web Services Device for Device type, type the IP address of the Fiery server, and click Next.

    Connection to the printer is initiated and the printer driver is installed.

11. Click Next and follow the on-screen instructions.

    Do not share the printer and do not print a test page at this time.

To print documents from Windows applications

1. In the Windows application, select File > Print.

2. Select the Fiery server WSD printer from the printer pull-down menu.

3. Specify the print options, and click Print.
This chapter describes printer drivers and PPD (PostScript Printer Description) files, Fiery server print options, and where to set print options.

About printer drivers and printer description files

The Fiery server receives files from computers on the network, processes (RIPs) the files, and then sends them to the color press. Windows and Mac OS computers communicate with the Fiery server by means of a printer driver and a PostScript Printer Description (PPD) file. A PPD file contains information about the features and capabilities of a particular device (for example, what paper sizes and media types are supported). The PPD file for the Fiery server includes information about the features of both the color press and the Fiery server.

A printer driver manages printing communication between your application and the printer. It interprets the instructions generated by the application, merges those instructions with printer-specific options you set, and then translates all information into Adobe PostScript, a language the printer understands. In other words, the printer driver writes a PostScript file based on your original file and the options you set from the Print dialog box.

For information about the specific print options for the Fiery server, see the tables that begin on page 107.
Setting print options

Print options give you access to the special features of your color press and the Fiery server. You can specify print options in these areas:

• Setup
  Some settings are specified during Setup by the administrator. For information about the current default server settings, contact the administrator or operator.

• Applications
  With the printer drivers provided, you can specify job settings when you print a job.
  For more information, see “Printing from Windows computers” on page 31 and “Printing from Mac OS computers” on page 82.

• Color Setup
  Set the default CMYK/Grayscale Source, CMYK/Grayscale Processing Method, RGB Source, Separate RGB/Lab to CMYK Source, Output Profile, RGB/Lab Rendering Intent, Spot Color Matching, Gray (CMYK), Gray (RGB), Black Text and Graphics, and Black Overprint settings.
  For information about using Color Setup, see Color Printing.

• Hot Folders
  Assign a group of print options to a Hot Folder. When you specify print options for a Hot Folder, the print options are assigned to all jobs sent through that Hot Folder. These print options override any default options.
  For information, see Hot Folders Help.

• Overrides in Command WorkStation Job Properties
  To change job settings from Command WorkStation, double-click a job to display the Properties dialog box.
  For more information, see Command WorkStation Help.

Print option override hierarchy

The override hierarchy is as follows:

• Settings from the user’s printer driver override the Fiery server Setup settings.
• Settings assigned to Hot Folders override the user’s printer driver settings.
• Settings made from the job management tools (Command WorkStation Job Properties) override the user’s printer driver settings.
Print options and default settings

If you do not use the printer driver interface to configure a particular option, the Fiery server prints the job with the default setting. For options that the administrator configures, choosing Printer’s default results in the Fiery server printing the job with the factory default. For options that cannot be configured in Setup, the Fiery server prints the job with a preconfigured Printer’s default setting. When you select the printer driver for North America, the default Document Size is Letter or for International, the default Document Size is A4. For more information, see the following tables.

To determine the current Setup defaults, print the Configuration page from Command WorkStation. For information about how to print a Configuration page, see Configuration and Setup.

**NOTE:** A job uses the Fiery server default settings (unless otherwise specified) at the time it is processed for printing, not at the time it is sent to the Fiery server Hold queue.

The print option tables are organized according to the printer driver icons (tabs). Use the following links for quick access:

<table>
<thead>
<tr>
<th>Printer driver icon</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick Access (shortcuts)</td>
<td>page 36 or page 87</td>
</tr>
<tr>
<td>Job Info</td>
<td>page 107</td>
</tr>
<tr>
<td>Media</td>
<td>page 110</td>
</tr>
<tr>
<td>Layout</td>
<td>page 113</td>
</tr>
<tr>
<td>Color</td>
<td>page 118</td>
</tr>
<tr>
<td>Image</td>
<td>page 122</td>
</tr>
<tr>
<td>Finishing</td>
<td>page 124</td>
</tr>
<tr>
<td>Variable Data Printing (VDP)</td>
<td>page 126</td>
</tr>
<tr>
<td>Stamping/Watermark</td>
<td>page 128</td>
</tr>
</tbody>
</table>
## Job Info options

<table>
<thead>
<tr>
<th>Option</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Copies</strong></td>
<td>The maximum number of copies is 9999.</td>
</tr>
<tr>
<td><strong>Print Range</strong></td>
<td>Specify the page range or odd/even pages to print. For variable data printing jobs, a range of Records is selected for printing. For imposed variable data printing jobs, a range of Records &amp; Sheets is printed. For imposed jobs, a range of Sheet IDs is printed. This option is only accessible from Command WorkStation Job Properties.</td>
</tr>
<tr>
<td><strong>Destination</strong></td>
<td>Specify the location to output the print job. This option is only accessible from Mac OS X printer driver.</td>
</tr>
<tr>
<td><strong>Destination: Schedule printing</strong></td>
<td>Specify to perform advance print scheduling based on date and time. If you select On, select the date and time for the print job. The job is printed based on the date and time set on the Fiery server, not the client computer. If multiple jobs are selected and defined with the same date and time setting, job order is based on the alphabetical order of the file names. <strong>NOTE:</strong> This option is invalid if your job is sent to the Direct connection.</td>
</tr>
<tr>
<td><strong>File name</strong></td>
<td>Specify the file name for your job when you use Mail Box or Form Store. This option is only accessible from Mac OS X printer driver.</td>
</tr>
<tr>
<td><strong>User Authentication: User name</strong></td>
<td>If User Authentication is configured on the Fiery server, specify your User Name to print a job. Type your user name or domain\user name for user authentication.</td>
</tr>
<tr>
<td><strong>User Authentication: Password</strong></td>
<td>If User Authentication is configured on the Fiery server, specify your User Password to print a job. Type your local password or domain password for user authentication.</td>
</tr>
<tr>
<td><strong>User Authentication: Use Windows Login</strong></td>
<td>If you are logged on to your Windows computer, select Use Windows Login for user authentication. This option appears when you log on to your domain on your Windows computer. For more information, see Configuration and Setup.</td>
</tr>
<tr>
<td><strong>User Authentication: I’m a Guest</strong></td>
<td>Select On to allow guest printing. Guest printing must be set to On at the Fiery server. In Command WorkStation, the management of jobs is determined by how you log on to the Fiery server.</td>
</tr>
<tr>
<td><strong>Notes 1/Notes 2</strong></td>
<td>Specify information about the job. This field has a 31-character (alphanumeric and special characters) limit.</td>
</tr>
<tr>
<td><strong>Instructions</strong></td>
<td>Specify instructions for the operator about the job. This field has a 127-character (alphanumeric and special characters) limit.</td>
</tr>
<tr>
<td>Option</td>
<td>Information</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Print queue action   | Select the job action associated with a published queue.  
Select Print to send the file directly to printing.  
Select Print and hold to save the raster file after printing.  
Select Hold to spool the job until the operator takes further action. Held jobs can exist in a preprocessed or processed state.  
Select Process and hold to RIP (process), but not print a job.  
Select Print and delete to queue a job to be processed, printed, and then deleted. This action ensures that the printed job is not saved to the Printed list, which is often required for secure printing.  
This option is invalid if your job is sent to the Direct connection. |
| Proof Print          | Select Proof Print from the Print button to print a single copy of a job(s) to verify output.  
This action is only accessible from Command WorkStation Job Properties. |
| Secure print         | Use when printing sensitive or confidential documents.  
Specify an arbitrary password and re-enter it when you are present at the color press.  
For information, see the documentation that accompanies your color press. |
| Account ID           | Account ID is associated with the User ID. Both fields must be filled in when printing jobs. It is used to manage print job history on the Xerox Color C75 Press.  
The Account ID field has an 32-character (numeric) limit. |
| User ID              | User ID is used to manage print job history on the Xerox Color C75 Press.  
The User ID field has an 32-character (numeric) limit. |
| Password             | Password is associated with User ID. It is used to print job history on the Xerox Color C75 Press.  
The Password field has an 12-character (numeric) limit. |
| Control Bar          | Specify On to print a Control Bar (for print job identification) in the margin.  
This option is available as part of Fiery Graphic Arts Package, Premium Edition for the EX Print Server. For more information, see Fiery Graphic Arts Package.  
This option is available as part of the Fiery Productivity Package for the Integrated Fiery Color Server. For more information, see Color Printing.  
Printer’s default reflects the setting specified in Color Setup in Command WorkStation. |
### Option Information

<table>
<thead>
<tr>
<th>Option</th>
<th>Information</th>
</tr>
</thead>
</table>
| **Progressives** | Select to turn on the Progressives feature, a diagnostic tool used to show toner separations.  
This feature uses the Progressives values specified in Color Setup in Command WorkStation.  
This option is available as part of Fiery Graphic Arts Package, Premium Edition. For more information, see *Fiery Graphic Arts Package*.  
This option is not available for the Integrated Fiery Color Server.  
**NOTE:** The Progressives and Postflight features cannot be used at the same time. |
| **Postflight** | Specify whether or not you want to use the Postflight feature, a diagnostic tool that allows you to analyze how data is processed by the Fiery server.  
This option is available as part of Fiery Graphic Arts Package, Premium Edition for the EX Print Server. For more information, see *Fiery Graphic Arts Package*.  
This option is available as part of the Fiery Productivity Package for the Integrated Fiery Color Server. For more information, see *Color Printing*.  
**NOTE:** The Progressives and Postflight features cannot be used at the same time. |
## Media options

<table>
<thead>
<tr>
<th>Option</th>
<th>Information</th>
</tr>
</thead>
</table>
| **Use set page device media mapping** | Set Page Device (SPD) commands are instructions within PostScript, VIPP, and VPS files that specify certain attributes of a print job. You can turn on SPD Media Mapping in Fiery server Setup. For information about enabling in Setup, see *Configuration and Setup*. Select On to allow the Fiery server to recognize and apply certain attributes of a print job on a job-level basis, including:  
  - Paper attributes (for example, Media Type and Media Color)  
  - Finishing attributes (for example, stapling or folding)  
  - Generic attributes (for example, simplex or duplex, number of copies)  
This option is accessible only from Command WorkStation Job Properties.  
This option is not available for the Integrated Fiery Color Server.  
For more information, see Configure Help. |
| **Paper Catalog**             | Click Select to access the Paper Catalog utility, which retrieves all paper information from the color press.  
For information about accessing Paper Catalog, see *Utilities*. For information about using Paper Catalog, see Command WorkStation Help.  
**NOTE:** This option is invalid if your job is sent to the Direct connection.  
Access to Paper Catalog requires Two-Way Communication. For information about selecting Two-Way Communication, see printer driver Help. |
| **Media type**                | Specify the media type for your print job.  
For information about media types and paper specifications, see the documentation that accompanies the color press. |
| **Media weight**              | Select the weight for media used for your print job.  
Select Use Machine Settings to use the media that is set on the color press. |
<p>| <strong>Media color</strong>               | Specify the media when printing on colored paper. |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Information</th>
</tr>
</thead>
</table>
| **Document size** | Document size is the page size defined in your application's Print setup (or Page setup) dialog box.  
When printing one document page per sheet of paper, Document size is usually the same as output paper size. However, Document size may differ when printing booklets or imposing multiple document pages on a single sheet.  
Document size may also differ from output paper size when you use the Scale or Scale to fit options, in which case the document page size is scaled at a given percent to fit a certain paper size.  
To assign Document size, do one of the following:  
- Select the size from the available list. (SEF stands for Short Edge Feed; LEF stands for Long Edge Feed.)  
- Click Custom to select a non-standard paper size.  
For more information about Document size and Paper size, see page 138.  
For information about Scale and Scale to fit, see page 144.  
For information about printing custom page sizes, see page 137. |
| **Paper source** | Specify the paper tray that contains the paper to use for your print job.  
This option allows you to select a specific tray for your job. If you select the Auto tray select setting, the color press prints from any tray containing the paper size necessary for the job. This setting also allows the color press to automatically switch between trays, if the current tray becomes empty, while continuing to print.  
For information about setting your choice of media in one of the trays, see the documentation that accompanies your color press. |
| **Paper size** | Defines the size of the sheet of paper on which your job prints. It is the size of the physical sheet of paper in the color press tray.  
To assign paper size, do one of the following:  
- Select the size from the available list. (SEF stands for Short Edge Feed; LEF stands for Long Edge Feed.)  
- Click Custom to select a non-standard paper size.  
- Select Same as document size to print one document page per sheet of paper.  
For more information, see page 138. |
| **Tray alignment** | Select to adjust the image on the page to achieve alignment on both sides of a page when printing duplex.  
For more information, see Command WorkStation Help. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Productivity setting</td>
<td>Select the mode to use for printing at the highest possible speed of the color press, depending on the media. Specify Productivity Mode for coated and uncoated paper stocks of all media weights. Specify Standard Mode for media types other than coated or uncoated. The job is printed at the standard speed. <strong>NOTE:</strong> If your job consists of different media types that are not exclusively coated or uncoated, there will be a performance delay while the color press switches between the different media types.</td>
</tr>
<tr>
<td>Slip sheet</td>
<td>Select On to insert a slip sheet between copies or pages of multiple-copy jobs. This option is effective only for non-sorted or collated jobs.</td>
</tr>
<tr>
<td>Slip sheet page size</td>
<td>Specify the slip sheet page size by selecting from the list of available sizes. (SEF stands for Short Edge Feed; LEF stands for Long Edge Feed.)</td>
</tr>
<tr>
<td>Transparency interleave paper source</td>
<td>Select the paper source tray for transparency interleaving.</td>
</tr>
<tr>
<td>Transparency interleaving</td>
<td>Select On to print multiple transparency sheets separated by blank, plain paper pages.</td>
</tr>
<tr>
<td>Slip sheet paper source</td>
<td>Specify the paper tray to use for the slip sheet.</td>
</tr>
<tr>
<td>Slip sheet offset</td>
<td>Select to print the slip sheets offset from the pages in the job.</td>
</tr>
<tr>
<td>Mixed media</td>
<td>Specify different media types, paper source, and chapter-based finishing for pages, or ranges of pages, within a print job. For more information, see printer driver Help. For information about accessing and using Mixed media in Command WorkStation, see Command WorkStation Help. Features specific to the Fiery server are described in <em>Utilities.</em></td>
</tr>
</tbody>
</table>

Option Information
Layout options

The printer driver has the following layout modes:

- Normal: use these options for printing standard documents, from 1 to 16 document pages per sheet (page 113).
- Gangup: use these options for speed printing imposition modes (page 114). For additional information, see page 141.
- Booklet: use these options for printing documents in booklet layout (page 115). For additional information, see page 130.
- Impose: use imposition layouts for custom printing, binding, and trimming (page 117).

<table>
<thead>
<tr>
<th>Option</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orientation override</td>
<td>Depending on the application you are using, a Landscape job might print with the incorrect orientation. If this occurs, use this option to correct the orientation of your job. This option is accessible only from Command WorkStation Job Properties.</td>
</tr>
<tr>
<td>Mirror</td>
<td>Select to print the mirror image of the job.</td>
</tr>
<tr>
<td></td>
<td>This option is not available from the Mac OS X printer driver and Command WorkStation Job Properties.</td>
</tr>
<tr>
<td>Duplex</td>
<td>Select Off for single-sided printing.</td>
</tr>
<tr>
<td></td>
<td>Specify Top-Top or Top-Bottom for duplex (double-sided) printing by specifying the orientation of printed images. For more information, see page 139.</td>
</tr>
<tr>
<td>Scale</td>
<td>Specify an increase or decrease in the scale of your print job. When using the manual Scale option, you cannot specify Scale to fit. For more information, see page 144.</td>
</tr>
<tr>
<td>Scale to fit</td>
<td>Specify whether to scale your job to fit to a paper size. When using the Scale to fit option, you cannot use the manual Scale option. For more information, see page 144.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Specify Portrait or Landscape page orientation for the document.</td>
</tr>
<tr>
<td></td>
<td>This option is not available from the Mac OS X printer driver and Command WorkStation Job Properties.</td>
</tr>
<tr>
<td>Rotate 180</td>
<td>Select to rotate the pages of a job 180 degrees.</td>
</tr>
<tr>
<td>Print border</td>
<td>Select On to print borders around each page in your print job.</td>
</tr>
<tr>
<td>Option</td>
<td>Information</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Pages per Sheet</td>
<td>Specify the number of document pages per sheet of paper for your print job. This option cannot be used with the Create Master or Use Master options.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> This option is invalid if your job is sent to the Direct connection.</td>
</tr>
<tr>
<td>Page Order</td>
<td>Specify the layout direction when the Pages per Sheet option is set to 2-up or greater.</td>
</tr>
<tr>
<td><strong>Gangup options</strong></td>
<td><strong>NOTE:</strong> The Gang-up feature is not valid if your job is sent to the Direct connection.</td>
</tr>
<tr>
<td>Gangup</td>
<td>Select On to specify options for speed printing imposition modes.</td>
</tr>
<tr>
<td>Gang-up type</td>
<td>Select Step &amp; repeat to speed print a job by printing two document pages on each sheet. When the printed sheets are cut in half, the result is two complete sets of the same document.</td>
</tr>
<tr>
<td></td>
<td>Select Cut &amp; stack to speed print a job by printing two document pages side by side. When the printed sheets are cut in half and stacked together, the result is one complete set of the document (in faster printing time).</td>
</tr>
<tr>
<td></td>
<td>For more information, see page 141.</td>
</tr>
<tr>
<td>Paper size</td>
<td>Defines the size of the sheet of paper on which your job prints. It is the size of the physical sheet of paper in the color press tray. To assign Paper size, select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Select the size from the available list. (SEF stands for Short Edge Feed; LEF stands for Long Edge Feed.)</td>
</tr>
<tr>
<td></td>
<td>• Select From Paper Catalog to access a dynamic database that stores the media attributes of any paper available for printing from the Fiery server.</td>
</tr>
<tr>
<td></td>
<td>• Select Custom Paper Size to select a non-standard paper size.</td>
</tr>
<tr>
<td></td>
<td>• Select Same as document size to print one document page per sheet of paper.</td>
</tr>
<tr>
<td></td>
<td>For more information about Paper size and Document size, see page 138.</td>
</tr>
<tr>
<td></td>
<td>For information about printing custom page sizes, see page 137.</td>
</tr>
<tr>
<td></td>
<td>For information about accessing Paper Catalog, see Utilities. For information about using Paper Catalog, see Command WorkStation Help.</td>
</tr>
<tr>
<td>Shrink to fit</td>
<td>Automatically scales down or reduces the document page size to fit the imageable area of the selected paper size specified from the Paper size menu. Shrink to fit does not scale up or enlarge.</td>
</tr>
<tr>
<td></td>
<td>When Shrink to fit is set to Off, page contents print at 100%.</td>
</tr>
</tbody>
</table>
### Page Alignment:
**Increase gutter by**
- **0/-50.0-50.0 mm**
  - **(0.1 mm increments)**
- **0/-1.969-1.969 in**
  - **(0.001 inch increments)**

Controls the amount of space between adjacent pages on a sheet to adjust for trimming or other finishing options.

- Specify a positive value to increase the amount of blank space between adjacent pages.
- Specify a negative value to decrease the amount of blank space between adjacent pages.

### Duplex
Select Off for single-sided printing.

Specify Top-Top for duplex (double-sided) printing to specify the orientation of printed images.

For more information, see page 139.

---

### Booklet options from the printer driver

**The following table references the Booklet Maker print options accessible from the printer driver. For the Booklet Maker print options accessible from Command WorkStation Job Properties, see “Booklet Maker in Job Properties” on page 133.**

**NOTE:** The Booklet Maker feature is not valid if your job is sent to the Direct connection.

**NOTE:** You can use the Booklet Maker Wizard to specify booklet options by clicking Launch Wizard.

<table>
<thead>
<tr>
<th>Option</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Booklet</strong></td>
<td>Select On to specify options for printing documents in Booklet layout. Click Launch Wizard to specify how to arrange the pages of the job in special layouts for folding or cutting after printing.</td>
</tr>
<tr>
<td><strong>Booklet Type</strong></td>
<td>Booklet Type is a combination of binding method, which determines how the signatures of the booklet are folded and imposed, and binding edge, which determines the location of the spine of the booklet.</td>
</tr>
<tr>
<td><strong>Paper size:</strong> <strong>Paper Size for 2-up</strong></td>
<td>Defines the size of the sheet of paper (unfolded) on which a booklet is printed. To assign a Paper size for a booklet, select one of the following:</td>
</tr>
<tr>
<td></td>
<td>- Select from the list of available sizes. (SEF stands for Short Edge Feed; LEF stands for Long Edge Feed.)</td>
</tr>
<tr>
<td></td>
<td>- Select From Paper Catalog to access a dynamic database that stores the media attributes of any paper available for printing from the Fiery server.</td>
</tr>
<tr>
<td></td>
<td>- Select Custom Paper Size to select a non-standard Paper size.</td>
</tr>
<tr>
<td></td>
<td>- Select Same as document size to print one document page per sheet of paper.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Booklet Maker Help.</td>
</tr>
</tbody>
</table>

For information about Paper size and Document size in booklets, see page 138 and Booklet Maker Help.

For information about accessing Paper Catalog, see Utilities. For information about using Paper Catalog, see Command WorkStation Help.

For information about printing custom page sizes, see page 137.
<table>
<thead>
<tr>
<th>Option</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Paper size:</strong> Shrink to fit</td>
<td>Automatically scales down or reduces the document page size to fit the imageable area of the selected paper size specified from the Paper size menu. Shrink to fit does not scale up or enlarge.</td>
</tr>
<tr>
<td></td>
<td>When Shrink to fit is set to Off, page content prints at 100%.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Booklet Maker Help.</td>
</tr>
<tr>
<td><strong>Subset Size:</strong> Number of sheets in a subset (Saddle)</td>
<td>When Nested Saddle is selected, use this option to specify the number of sheets in each subset. This option appears only when Nested Saddle is selected.</td>
</tr>
<tr>
<td><strong>Page Alignment:</strong> Centering adjustment</td>
<td>Centering adjustment positions page content in relation to the center of one-half the paper size or the spine, the center of the sheet where the fold occurs.</td>
</tr>
<tr>
<td></td>
<td>&quot;At the center&quot; positions page content in the center of <em>one-half</em> the specified paper size.</td>
</tr>
<tr>
<td></td>
<td>&quot;At the spine&quot; aligns page content with the spine or center fold of your booklet.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Booklet Maker Help.</td>
</tr>
<tr>
<td><strong>Page Alignment:</strong> Increase gutter by 0/-50.0-50.0 mm (0.1 mm increments) 0/-1.969-1.969 in (0.001 inch increments)</td>
<td>Increase gutter by controls the amount of space between adjacent pages to adjust for binding or other finishing options.</td>
</tr>
<tr>
<td></td>
<td>Specify a positive value to increase the amount of blank space between adjacent pages.</td>
</tr>
<tr>
<td></td>
<td>Specify a negative value to decrease the amount of blank space between adjacent pages.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Booklet Maker Help.</td>
</tr>
<tr>
<td><strong>Page Alignment:</strong> Compensate creep</td>
<td>Compensate creep adjusts the position of the page content to counteract the shift that occurs when sheets are folded to create Saddle and Nested Saddle booklets.</td>
</tr>
<tr>
<td></td>
<td>Select Plain when printing Saddle or Nested Saddle booklets with a large number of pages.</td>
</tr>
<tr>
<td></td>
<td>Select Thick when printing Saddle or Nested Saddle booklets on heavyweight paper.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Booklet Maker Help.</td>
</tr>
<tr>
<td><strong>Cover:</strong> Content input</td>
<td>Select Front &amp; Back Separately to include cover content (individual pages in your document) as part of your booklet print job.</td>
</tr>
<tr>
<td></td>
<td>Select Pre-Printed (use insert) to insert a pre-printed cover that is added to the body pages from an inserter tray.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Booklet Maker Help.</td>
</tr>
<tr>
<td><strong>Cover:</strong> Front cover</td>
<td>When Front &amp; Back Separately is selected, use the Front cover option to define how the content of the front cover is printed.</td>
</tr>
<tr>
<td></td>
<td>Select Print on outside to print only on the outside of the front cover (the inside of the front cover is blank).</td>
</tr>
<tr>
<td></td>
<td>Select Print on inside to print only on the inside of the front cover (the outside of the front cover is blank).</td>
</tr>
<tr>
<td></td>
<td>Select Print on both sides to print on both the inside and outside of the front cover.</td>
</tr>
<tr>
<td></td>
<td>Select Do not print if you do not want any content printed on the front cover.</td>
</tr>
<tr>
<td></td>
<td>When you add a cover, blank pages may be inserted, depending on the allocation of pages to signatures. For more information, see Booklet Maker Help.</td>
</tr>
</tbody>
</table>
### Cover: Back cover
When Front & Back Separately is selected, use the Back cover option to define how the content of the back cover is printed.
- Select Print on outside to print only on the outside of the back cover (the inside of the back cover is blank).
- Select Print on inside to print only on the inside of the back cover (the outside of the back cover is blank).
- Select Print on both sides to print on both the inside and outside of the back cover.
- Select Do not print if you do not want any content printed on the back cover.

When you add a cover, blank pages may be inserted, depending on the allocation of pages to signatures in the job. For more information, see Booklet Maker Help.

### Cover: Define Cover (for Saddle books only)
Click Define Cover to specify the following cover options: Cover source, Color mode, Media, Media type, and Media weight.

## Impose options

<table>
<thead>
<tr>
<th>Option</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Impose</strong></td>
<td>Select On to specify an imposition layout for a job.</td>
</tr>
<tr>
<td><strong>Templates</strong></td>
<td>Specify an imposition layout template for a job.</td>
</tr>
<tr>
<td></td>
<td>The available templates are as follows:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Normal</strong>: Default Template and 1-up full bleed</td>
</tr>
<tr>
<td></td>
<td>- <strong>Booklet</strong>: 2-up perfect, 2-up saddle, and 4-up head to head</td>
</tr>
<tr>
<td></td>
<td>- <strong>Gangup</strong>: 3-up trifold brochure, 4-up gate fold, and 4-up z fold</td>
</tr>
<tr>
<td><strong>Edit Impose Template</strong></td>
<td>Click Edit Impose Template to open a template in Fiery Impose for editing.</td>
</tr>
<tr>
<td></td>
<td>For information about Impose, see <em>Utilities</em>. For information about using Impose, see Command WorkStation Help.</td>
</tr>
</tbody>
</table>
## Color options

<table>
<thead>
<tr>
<th>Option</th>
<th>Information</th>
</tr>
</thead>
</table>
| Color mode              | Specify the Color mode for the current print job.  
Select CMYK for a full-color document.  
Select Grayscale for a grayscale or black-and-white document.  
Select Basic Settings to specify color print options and settings.  
Select Expert Settings to edit other color print options and settings, including Black Overprint, Black Text and Graphics, Gray (CMYK), and Gray (RGB).  
For information about Expert Settings, see page 119.                                                                                   |
| Auto trapping           | Select if the job should automatically reduce white gaps for text and graphics.  
Setting this option to On may result in graphics or text surrounded with borders.  
For more information, see page 130.                                                                                                       |
| Black detection         | When printing jobs with both black-and-white and color pages, use this option to detect black-and-white pages before the job prints.  
Select if the job is predominantly black and white.  
Clear the check box if the job contains a significant number of color pages.  
For more information, see Color Printing.                                                                                                  |
| Composite overprint     | Select On to overprint objects that are specified in the source PostScript or PDF file.  
Design applications are typically set to knock out objects. To overprint, you must first change the settings in the source application. When the Composite overprint option is then set to On, the overprinting commands specified in the source application take place, provided the output is composite and consistent with the separations output.  
For more information, see Color Printing.                                                                                                  |
| Combine separations     | When printing separations from supported desktop publishing applications:  
Select to combine separations on a single page.  
Clear the check box to view separations as four individual black-and-white pages, each representing one color plate.  
For more information, see Color Printing.                                                                                                  |
| Substitute colors       | Select to use the Substitute color values defined in Spot-On.  
For more information, see Color Printing.                                                                                                  |
**Expert Settings options**

To access the following options, click Expert Settings.

Expert Settings modes are as follows:

- **Color Input**: use these options for color printing (page 119).
- **Gray & Black Processing**: use these options for grayscale or black-and-white printing (page 121).
- **Output**: specify the output profile to use for printing a document (page 121).

### Color Input

<table>
<thead>
<tr>
<th>Option</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CMYK/Grayscale Source</strong></td>
<td>Specify the simulation profile for the current print job.</td>
</tr>
<tr>
<td></td>
<td>For more information, see <em>Color Printing</em>.</td>
</tr>
<tr>
<td><strong>Use embedded profile when present (CMYK)</strong></td>
<td>When this option is turned on, the Fiery server ignores the CMYK/Grayscale Source option and uses the CMYK profile embedded in the print job as the CMYK source profile.</td>
</tr>
<tr>
<td><strong>CMYK/Grayscale Processing method</strong></td>
<td>Specify the simulation method for CMYK print jobs.</td>
</tr>
<tr>
<td></td>
<td>Select Full (Source GCR) for a more complete and accurate simulation. Full (Source GCR) applies colorimetric transformations that adjust hue as well as output density and produces output that maintains the same amount of black as the source document.</td>
</tr>
<tr>
<td></td>
<td>Select Full (Output GCR) to apply the same simulation method as Full (Source GCR), except that the output produced contains a black amount determined by the Output Profile.</td>
</tr>
<tr>
<td></td>
<td>Select Pure Primaries to use one-dimensional transfer curves to adjust density output of individual color channels.</td>
</tr>
<tr>
<td></td>
<td>For more information, see <em>Color Printing</em>.</td>
</tr>
<tr>
<td>Option</td>
<td>Information</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Paper simulation                 | Specify to adjust the color according to the shade of the paper stock used as printable CMYK values in the output color space.  
This option is available as part of the Fiery Graphic Arts Package, Premium Edition for the EX Print Server. For more information, see Fiery Graphic Arts Package. |
| PDF/X output intent              | Specify On to use the embedded output intent for PDF/X compliant print jobs.  
To use this option, you must turn on the Use Embedded Profile When Present (RGB) option.  
This option is only accessible from Command WorkStation Job Properties.  
For more information, see Color Printing. |
| RGB Source                       | Specify a source color space definition for printing RGB images, objects, and text.  
For more information, see Color Printing. |
| Use embedded profile when present (RGB) | When this option is turned on, the Fiery server ignores the RGB Source option and uses the RGB profile embedded in the print job as the RGB source profile. |
| RGB rendering intent            | Specify a default CRD (color rendering dictionary) for color conversion when printing RGB images, objects, and text.  
Select Presentation to print files with artwork, graphics, and text. The result is similar to Photographic, with well-rendered flesh tones and more saturated colors.  
Select Photographic to print photographs, including scanned and digital camera images. The result is less saturated than Presentation style.  
Select Relative Colorimetric when color matching is important, but you also want to print white as paper white. The white point transformation eliminates borders between blank spaces and white objects.  
Select Absolute Colorimetric when exact colors are required and visible borders are not distracting. There is no white point transformation.  
For more information, see Color Printing. |
| Separate RGB/Lab to CMYK source | Select for RGB jobs to simulate an output device other than the device to which you are printing.  
For more information, see Color Printing. |
| Spot color matching              | Select Off to print specified PANTONE colors in your job using the current CMYK/Grayscale Source and CMYK/Grayscale Processing Method.  
Select On to activate the PANTONE Lookup Table. The Fiery server prints specified PANTONE colors in your job by matching the CMYK print blend to the same color from the PANTONE library.  
For more information, see Color Printing. |
### Gray & Black Processing

<table>
<thead>
<tr>
<th>Option</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gray (CMYK)</td>
<td>Select these settings to print a CMYK job using black toner instead of process black. This option renders the selected object types (Text/Graphics or Text/Graphics/Images) in grayscale using black only, when C=M=Y=0 and K=n, where n is not zero. (Graphics refer to vector graphics; Images refer to raster images.) This option is designed to use black efficiently, by using only black toner (rather than four-color process black). For more information, see <em>Color Printing</em>.</td>
</tr>
<tr>
<td>Gray (RGB)</td>
<td>Select these settings to print an RGB job using black toner instead of process black. This option renders the selected object types (Text/Graphics or Text/Graphics/Images) in grayscale using black only, when R=G=B. (Graphics refer to vector graphics; Images refer to raster images.) This option is designed to use black efficiently, by using only black toner (rather than four-color process black). For more information, see <em>Color Printing</em>.</td>
</tr>
<tr>
<td>Black text and graphics</td>
<td>Select Normal to print black text and graphics as a four-color black using C, M, Y, and K toner, and to use normal PostScript rendering. Select Pure Black On to print black text and graphics as a one-color black, using black toner only. Select Rich Black On to print black text and graphics as richer looking black, by layering a small amount of Cyan toner underneath the black toner to make the black even darker. This option is automatically set to Pure Black On if the Black overprint option is turned on. For more information, see <em>Color Printing</em>.</td>
</tr>
<tr>
<td>Black overprint (for pure black)</td>
<td>Select Text to overprint black text. Select Text/Graphics to overprint black text and graphics. For more information, see <em>Color Printing</em>.</td>
</tr>
</tbody>
</table>

### Output

<table>
<thead>
<tr>
<th>Option</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default output profile</td>
<td>Specify the output profile to use for the current print job. For information about output profiles, see <em>Color Printing</em>.</td>
</tr>
<tr>
<td>Use media defined profile (if available)</td>
<td>Select to automatically apply the output profile associated with the media type used in a print job. For more information, see <em>Color Printing</em>.</td>
</tr>
</tbody>
</table>
**Image options**

For information about options specified in Setup, see *Configuration and Setup.*

<table>
<thead>
<tr>
<th>Option</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Halftone simulation</strong></td>
<td>Specify a halftone screening method for your print job.</td>
</tr>
<tr>
<td></td>
<td>Select Application Defined to use the screening set by the application.</td>
</tr>
<tr>
<td></td>
<td>Select Newsprint if you want a look similar to that of a newspaper.</td>
</tr>
<tr>
<td></td>
<td>Select User Defined Screen 1-3 to use the screening set by the Fiery server. The User Defined Screen 1-3 settings reflect the setting specified in Fiery server Setup.</td>
</tr>
<tr>
<td></td>
<td>This option is available as part of the Fiery Graphic Arts Package, Premium Edition for the EX Print Server. For more information, see <em>Fiery Graphic Arts Package.</em></td>
</tr>
<tr>
<td></td>
<td>This option is not available for the Integrated Fiery Color Server.</td>
</tr>
<tr>
<td><strong>Brightness</strong></td>
<td>Specify the image brightness for the printed document.</td>
</tr>
<tr>
<td></td>
<td>Select 85% for a substantially lighter image, 115% for a substantially darker image, or one of the settings in between.</td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td>Specify the resolution of the print job (specified in dots-per-inch).</td>
</tr>
<tr>
<td><strong>Image smoothing</strong></td>
<td>Select to minimize grainy output when printing low-resolution (up to 300dpi) images.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> This option is valid for images less than or equal to 150dpi when the Resolution option is set to 600dpi, and for images less than or equal to 300dpi when the Resolution option is set to 1200dpi.</td>
</tr>
<tr>
<td><strong>Image quality</strong></td>
<td>Specify the type of image quality for the job.</td>
</tr>
<tr>
<td></td>
<td>This option affects the fineness of images in the job; there is a trade-off with processing speed.</td>
</tr>
<tr>
<td><strong>Printer screen mode</strong></td>
<td>When printing graphics, specify one of the screens that are available on the color press when printing a job.</td>
</tr>
<tr>
<td><strong>Use maximum printer density</strong></td>
<td>This option is designed to create solid, saturated colors. It is typically used to print text and graphics, not photographic images.</td>
</tr>
<tr>
<td></td>
<td>Select to print 100% C, M, Y (or R, G, B) at the maximum density that the color press is capable of printing, regardless of calibration. C, M, Y (or R, G, B) values less than 100% still print at the calibrated density value.</td>
</tr>
<tr>
<td></td>
<td>For best results, set the CMYK/Grayscale Source or RGB Source to None.</td>
</tr>
<tr>
<td><strong>Gloss level</strong></td>
<td>Specify Standard or Glossy as the color press print mode to gloss the print job like a photograph.</td>
</tr>
<tr>
<td><strong>Text/graphics quality</strong></td>
<td>Specify the type of text and graphics quality for the print job.</td>
</tr>
<tr>
<td></td>
<td>The text/graphics quality affects the sharpness and fineness of text and graphics in the job, with a trade-off in processing speed.</td>
</tr>
<tr>
<td></td>
<td>Select Normal for a good quality and faster processing speed.</td>
</tr>
<tr>
<td></td>
<td>Select Best for the sharpest possible text and graphic edges with slower processing speed.</td>
</tr>
<tr>
<td><strong>Text sharpness correction</strong></td>
<td>Select to correct the sharpness of the text and graphics edges.</td>
</tr>
<tr>
<td>Option</td>
<td>Information</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Text/graphics edge enhancement</td>
<td>Select to sharpen the edges of text or vector graphics.</td>
</tr>
</tbody>
</table>
| Image Enhance: Apply image enhancement | Select to apply photo finishing enhancement to the job. The supported file formats are PDF, PS, TIFF, and EPS.  
**NOTE:** This option is not valid for images under 72dpi. Also, it is not applied to pages with a large number of images.  
For more information, see page 142. |
| Image Enhance: Image enhancement range | Specify all pages, specific page(s), or sheets of the document to apply photo finishing enhancement.                                           |
## Finishing options

<table>
<thead>
<tr>
<th>Option</th>
<th>Information</th>
</tr>
</thead>
</table>
| **Use set page device output bin tray mapping** | Select On to allow the Fiery server to map the Output Bin Tray on a job-level basis. Set Page Device (SPD) Media Mapping must be turned on in Fiery server Setup to use this option. For information about enabling in Setup, see Configuration and Setup.  
This option is only accessible from Command WorkStation Job Properties.  
This option is not available for the Integrated Fiery Color Server.  
For more information, see Configure Help. |
| **Subset finishing in use**                 | Select to use subset finishing for the job. A subset is defined as pages in continuous order.                                                                                                                                                                                                                                               |
| **Delivery Option: Collate**                | Specify how to output multiple-page/multiple-copy jobs.  
**NOTE:** This option is invalid if your job is sent to the Direct connection.  
For more information, see page 137.                                                                                                                                                                                                                                         |
| **Delivery Option: Offset Jobs**            | Select to offset (shift in output tray) the job.                                                                                                                                                                                                                                                                                             |
| **Delivery Option: Output tray**            | Specify the output tray for the job.                                                                                                                                                                                                                                                                                                       |
| **Delivery Option: Output delivery**        | Specify the output delivery for the printed job.  
Select Face down - normal order to print your document on the bottom of the sheet of paper (the document outputs from the color press with the text facing down) in normal (1-N) order.  
Select Face up - normal order to print your document on the top of the sheet of paper in normal (1-N) order.  
Select Face down - reverse order to print your document on the bottom of the sheet of paper (the document outputs from the color press with the text facing down) in reverse (N-1) order.  
Select Face up - reverse order to print your document on the top of the sheet of paper in reverse (N-1) order.  
For more information, see page 142.                                                                                                                                                                                                                      |
| **Image shift**                             | Select to adjust an image for duplex printing by shifting the image horizontally, in the direction of paper travel, relative to the leading edge.  
This option affects the offsetting of the image on the entire job, not on a per-page-basis. However, you can specify alignment settings for the front (odd) and back (even) pages.  
Image Shift settings are not available from inside Mixed Media.  
Image Shift is not supported for Booklet Maker and Gang-up printing.  
For more information, see printer driver Help.                                                                                                                                                                                                                           |
| **Fold style**                              | Specify a fold style for the print job.  
For more information, see page 140.                                                                                                                                                                                                                                                                                                  |
| **Fold order**                              | Specify whether the pages of your folded job print with the imageable area on the inside or outside of the folded sheet.  
For more information, see page 140.                                                                                                                                                                                                                                                                                       |
<table>
<thead>
<tr>
<th>Option</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stapler mode</td>
<td>Specify the number of staples and their positions.</td>
</tr>
<tr>
<td><strong>NOTE:</strong> Staple positions vary according to paper size, paper type, number of pages, and feed direction.</td>
<td></td>
</tr>
<tr>
<td>To use this option, you must install a finisher with stapling functionality.</td>
<td></td>
</tr>
<tr>
<td>Punch edge</td>
<td>Specify the location of punched holes.</td>
</tr>
<tr>
<td>To use this option, you must install a finisher with hole punching functionality.</td>
<td></td>
</tr>
<tr>
<td>For information about installing finishers and other installable options, see printer driver Help.</td>
<td></td>
</tr>
<tr>
<td>For more information about punch settings, see page 143.</td>
<td></td>
</tr>
<tr>
<td>Punch</td>
<td>Specify the number of holes to punch for your job.</td>
</tr>
<tr>
<td>To use this option, you must install a finisher with hole punching functionality.</td>
<td></td>
</tr>
<tr>
<td>For information about installing finishers and other installable options, see printer driver Help.</td>
<td></td>
</tr>
<tr>
<td>For more information about punch settings, see page 143.</td>
<td></td>
</tr>
<tr>
<td>Pad Printing: Enable pad printing</td>
<td>Select to print pads.</td>
</tr>
<tr>
<td>Pad is a collection of a single or multiple page job with multiple copies.</td>
<td></td>
</tr>
<tr>
<td>Pad Printing: Job copies per pad</td>
<td>Specify the number of pad copies to print.</td>
</tr>
<tr>
<td>Pad Printing: Back cover paper source</td>
<td>Specify the paper source tray to use for the pad back cover.</td>
</tr>
<tr>
<td>Pad Printing: Offset pads</td>
<td>Select to offset (shift in output tray) the pads.</td>
</tr>
<tr>
<td>Pad Printing: Add pad back cover</td>
<td>Select to add a back cover at the end of the pad.</td>
</tr>
<tr>
<td>Cover page options: Cover page face-down printing</td>
<td>Select the delivery for a cover page on per job basis.</td>
</tr>
<tr>
<td>Cover page options: Cover page feed direction</td>
<td>Select Long edge or Short edge for the orientation of the cover page.</td>
</tr>
<tr>
<td>Trim: Spine pressing</td>
<td>Use to compress the spine edge of your booklet print job.</td>
</tr>
<tr>
<td><strong>NOTE:</strong> This option requires a 5-sheet minimum.</td>
<td></td>
</tr>
<tr>
<td>Trim: Engage fore (face trim)</td>
<td>Select to trim the edges of your booklet print job.</td>
</tr>
<tr>
<td><strong>NOTE:</strong> This option uses a standard calculation based on the number of sheets, page size, media type and weight, and spine width of your booklet. Use the separate Trim Adjustment option to fine-tune the amount of trimming.</td>
<td></td>
</tr>
<tr>
<td><strong>NOTE:</strong> To use this option, you must install a finisher with trimming capabilities.</td>
<td></td>
</tr>
<tr>
<td>Trim: Finish size</td>
<td>When Engage Fore (Face) is selected, use to specify the finished booklet size after trimming.</td>
</tr>
<tr>
<td>The finish size increment is 0.1 mm (0.001 inch).</td>
<td></td>
</tr>
<tr>
<td>Trim: Trim value</td>
<td>When Engage Fore (Face Trim) is selected, use to adjust the amount of trimming.</td>
</tr>
<tr>
<td>The trim value increment is 0.1 mm (0.001 inch).</td>
<td></td>
</tr>
</tbody>
</table>
Variable Data Printing (VDP) options

The Fiery server is compatible with the following variable data printing languages:

- FreeForm and FreeForm 2
- Portable Document Format/Variable Transactional (PDF/VT)
  This format is not available for the Integrated Fiery Color Server.
- Personalized Print Markup Language (PPML)
  This format is not available for the Integrated Fiery Color Server.
- Creo Variable Print Specification (VPS)
  This format is not available for the Integrated Fiery Color Server.
- Xerox Variable Data Intelligent PostScript Printware (VI_PP)
  This format is not available for the Integrated Fiery Color Server.

For more information about VDP languages, see Variable Data Printing.

VDP documents using FreeForm must have the following settings for the master document and variable document match:

- Color mode
- Combine separations
- Duplex
- Document size
- Stapler mode

The following setting for the variable document overrides the corresponding settings in the master document:

- Output tray

<table>
<thead>
<tr>
<th>Option</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create master</td>
<td>To create a FreeForm master from this job, specify a number to assign to the FreeForm master file. Command WorkStation allows you to select up to 100 FreeForm Masters. For more information, see Variable Data Printing.</td>
</tr>
<tr>
<td>Use master</td>
<td>For variable data print jobs, specify a FreeForm master number to be used for the job. Command WorkStation allows you to select up to 100 FreeForm Masters. For more information, see Variable Data Printing.</td>
</tr>
<tr>
<td>Preview Master</td>
<td>Click to generate a low-resolution image of your master page. Note: This option is not available for the Mac OS X v10.7 and v10.8 printer driver.</td>
</tr>
<tr>
<td>Option</td>
<td>Information</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Print master</td>
<td>Use to verify or confirm your Master page. For more information, see Variable Data Printing. Printer's default reflects the setting specified in Fiery server Setup.</td>
</tr>
<tr>
<td>Remove white PPT background</td>
<td>Select when using Microsoft Office PowerPoint to create variable data in conjunction with FreeForm. This option removes the white background from PowerPoint files.</td>
</tr>
<tr>
<td>File search path</td>
<td>Some PPML and other types of jobs do not contain all of the variable data job resources in a single file. In these cases, on a job per job basis, specify the location of the variable data job external resources so that the Fiery server can access them. For more information, see Variable Data Printing.</td>
</tr>
<tr>
<td>Enable enhanced FreeForm</td>
<td>Select to allow the mapping of select pages from the FreeForm master file in the desired order and merge with the variable file when the job is processed. <strong>NOTE:</strong> You cannot apply FreeForm settings to an imposed job. For more information, see Variable Data Printing.</td>
</tr>
<tr>
<td>Pages per record</td>
<td>Define record-based (rather than job-based) finishing, based on the number entered. This option is used with the Define Record Length option. For more information, see Variable Data Printing.</td>
</tr>
<tr>
<td>Define record length</td>
<td>Process a PDF or PostScript file like a variable data print job, and apply record-based finishing. This option is used in connection with the Pages Per Record option. For more information, see Variable Data Printing.</td>
</tr>
<tr>
<td>Cache PDF and PS objects</td>
<td>Select to cache PDF and PS objects, a feature that recognizes objects (text, images, vectors) within a PostScript or PDF file. PDF objects must be tagged as XObjects and PS objects must be in PS forms to be cached, which reduces the need to re-process image data for faster printing. This option is only accessible from Command WorkStation Job Properties. For more information, see Variable Data Printing.</td>
</tr>
</tbody>
</table>
## Stamping/Watermark options

<table>
<thead>
<tr>
<th>Option</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Watermark</strong></td>
<td>Select standard text for your watermark from the pull-down menu. To create your own watermark, click New. To modify a standard watermark, select it from the pull-down menu and click Edit. To remove a watermark from the list, select it from the pull-down menu and click Delete. For more information about using watermarks, see printer driver Help.</td>
</tr>
<tr>
<td><strong>Print Watermarks:</strong></td>
<td><strong>First Page Only</strong></td>
</tr>
<tr>
<td></td>
<td>Print watermarks on only the first page. For more information about using watermarks, see printer driver Help.</td>
</tr>
</tbody>
</table>
Overriding print option settings

Print option settings that were specified in the printer driver can be overridden in Command WorkStation Job Properties.

To override job properties

1 In Command WorkStation, right-click a held job in the Job Center view.
2 Select Properties.
3 Specify the print option settings, and then click Print.

You can override most print options in the printer driver and Command WorkStation Job Properties. Exceptions are listed in the following table:

<table>
<thead>
<tr>
<th>Printer driver tab</th>
<th>Option</th>
<th>Driver Win</th>
<th>Driver Mac</th>
<th>CWS</th>
</tr>
</thead>
<tbody>
<tr>
<td>JOB INFO</td>
<td>Print Range</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Print queue action</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Destination</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>File name</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Secure Print</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>User Authentication: Username</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>User Authentication: Password</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>User Authentication: Use Windows Login</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>User Authentication: I'm a Guest</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>MEDIA</td>
<td>Document size</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Use set page device media mapping</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>LAYOUT: Normal</td>
<td>Mirror</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Orientation</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Orientation override</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>COLOR: Expert Settings</td>
<td>PDF/X output intent</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FINISHING</td>
<td>Use set page device output bin tray mapping</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VARIABLE DATA PRINTING</td>
<td>Cache PDF and PS objects</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STAMPING/WATERMARK</td>
<td>Watermarks</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Print Watermarks: First Page Only</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>ALL TABS</td>
<td>Adobe PDF Print Engine Preferred</td>
<td>X</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Additional information

The following sections provide additional information about print options. For more information about options, see the tables that begin on page 106.

Auto Trapping

Trapping is a technique to print some objects slightly larger or smaller than specified in an application, in order to prevent white edges around the objects. These white edges, or “halos,” can be caused by factors such as misregistration, the physical properties of the toners, and the stiffness of the media. The Auto Trapping feature provides you with advanced trapping settings and gives you full control over their values. For more information, see Color Printing.

Booklet Maker

Booklet Maker is the imposition tool that allows you to quickly print documents in booklet format, without the need for more involved page imposition programs. Booklet Maker provides advanced settings, while streamlining the booklet-making process by displaying only the options and controls relevant to your selections. Booklet Maker is capable of imposing jobs from nearly any application.

Access Booklet Maker in the printer driver when you print a job, or in Command WorkStation Job Properties.

NOTE: Mixed Media jobs and variable data printing jobs are not supported by Booklet Maker.
The following booklet layouts are available:

**Saddle binding:** Signatures are folded together as a group, and then stapled or stitched along the center fold, which forms the spine of the booklet.

**Nested Saddle binding:** Combines saddle and perfect binding methods by stacking two or more saddles (also called “groups” or “subsets”) together along the common fold, then gluing them together at the fold to form the spine.

**Perfect binding:** Separate, folded pages are printed and stacked in booklet order. Finished pages are stitched adjacent to one another for trimming or gluing.

For Booklet Maker options and available settings, see the table that begins on page 115.

For more information, see Booklet Maker Help.
Booklet Maker in the printer driver

You can work with Booklet Maker in the printer driver as follows:

- Using the Booklet Maker wizard
  Recommended for first-time or novice users.
- Specifying settings in the main Booklet Maker dialog box
  Recommended for experienced or advanced users.

For Booklet Maker options and available settings in the printer driver, see the table that begins on page 115.

To use Booklet Maker to print a booklet from the printer driver, use one of the following procedures.

To access Booklet Maker from the Windows printer driver

1 In your application, select File > Print.
2 Select the Fiery server as your printer and click Properties.
3 In the printer driver, click the Layout icon and select the Booklet option.

For more information, see Booklet Maker Help.

To access Booklet Maker from the Mac OS X printer driver

1 In your application, select File > Print.
2 Select the Fiery server as your printer, and select Fiery Features from the drop-down list.
3 Click Full Properties in the Quick Access pane.
4 In the printer driver, click the Layout icon and select the Booklet option.

For more information, see Booklet Maker Help.
Booklet Maker in Job Properties

You can work with Booklet Maker in Job Properties as follows:

- Using the Booklet Maker wizard
  Recommended for first-time or novice users.
- Specifying settings in the main Booklet Maker dialog box
  Recommended for experienced or advanced users.

To access Booklet Maker from Command WorkStation Job Properties, use the following procedure.

**To access Booklet Maker from Command WorkStation**

1. Double-click your print job in the Held or Printed list, or right-click the job and select Properties.
2. Click the Layout icon in the Job Properties window.
3. Select the Booklet option.
4. Specify the Booklet Maker settings or click Launch Wizard to specify the settings graphically.

For more information, see Command WorkStation Help.

About Booklet Maker imposition

Imposition is the process of printing multiple pages on single sheets of paper. When imposed sheets are folded together as signatures, the pages follow in sequential, or reading, order. Booklet Maker is designed for 2-up imposition, which imposes four individual pages from your document on a single sheet that is printed duplex.

The order in which pages are imposed is determined by the binding method that you select.

Booklet Maker and Impose

Booklet Maker settings are supported by Impose, if turned on. You can open a job with Booklet Maker settings in Impose to preview the imposition layout or further modify the imposition layout, if necessary.

Impose translates and maps all Booklet Maker settings to Impose commands.

**Note:** When a job with Booklet Maker settings has been edited in the Impose window, the job cannot be edited in Booklet Maker. Impose offers more settings that cannot be mapped to Booklet Maker settings.

For more information about Impose, see Utilities.
Main Booklet Maker window

In the main Booklet Maker window, Booklet Maker dynamically displays all of the controls applicable to creating a booklet.

To create a booklet

1. Select a Booklet Type: Saddle, Nested Saddle, or Perfect.
2. Select a binding edge: Left, Top, or Right.
4. Select Shrink to fit, if required.
5. Specify Page Alignment.
6. Specify creep compensation, if required.
   
   Creep compensation is available for Saddle and Nested Saddle booklets.
7. Specify cover settings, if you selected a Saddle booklet in step 1.
   
   Note: Cover settings are only available for Saddle booklets. For more information, see “Adding a cover” on page 135.
8. Click OK to save your settings, Cancel to cancel the job, or Print to print your job.

Booklet Maker wizard

In the Booklet Maker wizard, accessed by clicking Launch Wizard, the windows display the steps in the booklet-making process.

To navigate the wizard

- To advance from one window to the next, click Next.
- To return to the previous windows, click Back.
- To cancel settings and exit Booklet Maker, click Cancel.

To create a booklet using the wizard

1. Click Launch Wizard.
2. Specify the Booklet Type (binding method) and binding edge.
3. If Saddle was selected for Booklet Type, specify cover and content settings, and then click Next.
4. Specify paper size for the body, and then click Next.
   
   If Saddle was selected for Booklet Type, specify the paper settings for the cover, and then click Next.
   
   If Nested Saddle was selected for Booklet Type, specify number of sheets in a subset.
5 Specify body alignment, and then click Next.
   If Saddle or Nested Saddle was selected for Booklet Type, specify creep compensation.

6 View the settings summary.

7 Click Finish to save your booklet, Back to change any settings, or Cancel to cancel the job.

Adding a cover
Covers are an option for Saddle booklets only.

To insert a preprinted cover
1 In the main Booklet Maker window, select Saddle for Booklet Type and a binding edge.
2 Specify the required settings for Paper Size and Page Alignment for the body of the booklet.
3 Select Pre-Printed from the Cover content input menu.
4 Click Define Cover and specify the cover media settings.
5 Click OK.

To specify an inline cover
1 In the main Booklet Maker window, select Saddle for Booklet Type and a binding edge.
2 Specify the required settings for Paper Size and Page Alignment for the body of the booklet.
3 Select Front & Back Separately from the Cover Content input menu.
4 Specify the Front Cover and Back Cover settings.
5 Click Define Cover and specify the cover media settings.
6 Click OK.

Note: When you print an inline cover with top-edge binding, the outside back cover automatically rotates 180 degrees to match the orientation of the front cover.
Cover options

For Saddle only, Booklet Maker includes two cover options: pre-printed or inline, for which you can specify media. You can specify additional options for an inline cover.

- **Content input:** Select from Front and Back Separately or Pre-Printed.

- **Front and Back Separately:** Select this option to specify an inline cover that prints the cover pages and body pages as a single job. Separate pages from your document are imposed on a single sheet that forms the cover pages of your booklet.

  You can specify an inline cover when your original document includes the cover pages and/or cover artwork for your booklet. The cover content may be the first and last pages of your document, or the first two and last two pages of your document, or any combination.

  If you select this option, you can specify the Front cover and Back cover options.

- **Pre-Printed:** Select this option to insert a pre-printed cover that will be merged with the body pages of your booklet, which print separately.

  If you select this option, the Front cover and Back cover options are disabled.

- **Front cover and Back cover:** These options allow you to quickly decide whether your front and back covers print duplex, single-sided, or both sides blank, without needing to add blank pages in your original document.

  With top-edge binding that includes a cover, the outside of the back cover automatically rotates 180 degrees to match the orientation of the front cover.

- **Define Cover:** This option allows you to select cover media settings for your cover pages, which may be trimmed. This option is available for both pre-printed and inline covers.

Printing Booklet Maker jobs

Booklet Maker does not support jobs sent to the Direct queue. Booklet Maker print jobs must be sent to the Print queue or Hold queue.

Setting measurement units in Command WorkStation

You can change the default unit of measurement for all input fields in the Command WorkStation Preferences dialog box. Units specifies the units of measurement used to display attributes, such as page sizes and custom sizes, that you enter in the Job Properties dialog box. This setting does not affect predefined page-size values.

**To change the unit of measurement**

1. In Command WorkStation, select Edit > Preferences.
2. Click Regional Settings.
3. Select the unit of measurement (millimeters, points, or inches).
4. Click OK.

The changes are not effective until Command WorkStation is restarted.
Collate

Use this option to specify sorting options.

**NOTE:** This option is invalid if your job is sent to the Direct connection.

**On:** Copies of a complete job are sorted as 1-N, 1-N.

**Off:** Copies of a complete job are sorted as 1,1, 2,2, 3,3.

**NOTE:** The collation of Mixed Media and Variable Data Printing (VDP) jobs is handled differently. For Mixed Media jobs, copies of a complete job are sorted according to finishing set. For VDP jobs, copies of a complete job are sorted per record.

For more information about VDP, see *Variable Data Printing*, and for information about Mixed Media, see *Utilities*.

Defining and printing custom page sizes

With custom page sizes, you define the dimensions of a printed page. After you define a custom page size, you can use it from within an application without redefining it each time you print. When you create custom page sizes, specify Width dimensions to correspond with the shorter side of your job and specify Height dimensions to correspond with the longer side of your job. Set custom page sizes in this way, regardless of the orientation settings in the application.

**NOTE:** Custom page sizes are not supported with Imposition jobs.

For information about defining and printing custom pages sizes, see printer driver Help.
Document size and Paper size

Document size is the page size defined in your application’s Print setup (or Page setup) dialog box. Paper size is the size of the actual sheet of paper on which your job is printed. It may be useful to think of Document size as digital input (the page size defined in your original document) and Paper size as the physical output (the actual size of the paper in the color press tray).

In cases when you print one document page per sheet of paper, Document size is usually the same as the Paper size. However, Document size may differ from Paper size when you print booklets or impose multiple document pages on a single sheet.

The following illustrations show examples of possible relationships between Document size and Paper size. Note that the orientation of all pages shown is Landscape.

<table>
<thead>
<tr>
<th>Document size (input)</th>
<th>Paper size (output)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document size is the same as Paper size. Scaling is 100%.</td>
<td>Letter</td>
</tr>
<tr>
<td>Tabloid Document size scaled to fit on Letter Paper size. Scaling is 50%.</td>
<td>Tabloid 11x17</td>
</tr>
<tr>
<td>A4 Document size scaled to fit on A3 Paper size. Scaling is 141%.</td>
<td>A4</td>
</tr>
</tbody>
</table>

Document size may also differ from Paper size when using the Scale or Scale to fit options. The Scale option reduces or enlarges the document page at a specified percent. The Scale to fit option automatically reduces or enlarges the document image to fit the selected Paper size.

For information about Scale and Scale to fit, see page 144.

For information about Document size and Paper size in booklet printing, see Booklet Maker Help.
Duplex printing

To print duplex (double-sided) pages

1 In your application, select File > Print, select the Fiery server as your printer, and do one of the following:

   Mac OS X: Select Fiery Features from the drop-down list, click Full Properties in the Quick Access pane, and then select Normal on the Layout tab.

   Windows: Click Properties, and then click the Layout icon.

2 Select one of the Duplex settings:

   Top-Top: Prints the top of the image on Side 1 on the same edge of the page as the top of the image on Side 2.

   Top-Bottom: Prints the top of the image on Side 1 on the opposite edge of the page from the top of the image on Side 2.

The following table shows how the Duplex settings correspond to printed output.

<table>
<thead>
<tr>
<th>Portrait</th>
<th>Top-Top</th>
<th>Top-Bottom</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image1.png" alt="Diagram" /></td>
<td><img src="image2.png" alt="Diagram" /></td>
</tr>
<tr>
<td></td>
<td><img src="image3.png" alt="Diagram" /></td>
<td><img src="image4.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>

3 Print the job.
Fold style options

The following types of fold are supported:

- **Half-fold**
- **Half Z-fold**
- **Tri-fold**
- **Booklet-fold**
- **Z-fold**

A finisher capable of folding must be installed on the color press to use the Fold option.

**NOTE:** When you select a folding option, Output Delivery is automatically set to Face down-normal order. It is not possible to print folded jobs face up or in reverse order. The Fold order option allows you to specify whether text/images print on the inside or outside of the folded sheet.

For information about finishers and other installable options, see printer driver Help.
Gang-up printing

The Fiery server includes two speed-printing options:

**Step & repeat:** Select this option to speed print a job so that the first page of your document is printed twice on the first sheet. The next sheet duplicates the data on the second page, the next sheet duplicates the data on the third page, and so on. When the printed sheets are cut in half, the result is two complete sets of the same document.

**Cut & stack:** Select this option to speed print a job so that when the sheets are stacked and cut from the central position, the job is numbered in order and separated as two stacks. The print order is such that when the sheets are cut in half, you can combine them to form a single complete set of the document, in faster printing time.

---

**To access Gang-up print from the Windows printer driver**

1. In your application, select File > Print.
2. Select the Fiery server as your printer and click Properties.
3. In the printer driver, click the Layout icon and select the Gangup option.

**To access Gang-up print from the Mac OS X printer driver**

1. In your application, select File > Print.
2. Select the Fiery server as your printer and select Fiery Features from the drop-down list.
3. Click Full Properties in the Quick Access pane.
4. In the printer driver, click the Layout icon and select the Gangup option.
Image Enhance

The Image Enhance feature lets you apply photo finishing enhancement to color images on specified pages or sheets of a job. This feature affects only photographic images, not graphics such as logos or charts. To turn on this feature, select the Apply Image Enhancement option for a job and specify the pages or sheets to be affected. This option is located in the Image tab of the printer drivers and Command WorkStation Job Properties. You can customize Image Enhance settings from Command WorkStation. For more information, see Command WorkStation Help and Color Printing.

Output Delivery

Output delivery allows you to specify how the stack of copies is delivered in the output tray.

Select Face up for sheets delivered into the output tray with copies facing up, with normal order for the first sheet on the top of the stack, or reverse order for the first sheet on the bottom of the stack.

1 Face up - normal order
2 Face up - reverse order

Select Face down for sheets delivered into the output tray with copies facing down, with normal order for the first sheet on the bottom of the stack, or reverse order for the first sheet on the top of the stack.

1 Face down - normal order
2 Face down - reverse order

**NOTE:** When using a finisher that reverses the order of the stack, you can specify normal order so that when the stack is fed through the finisher, the pages are delivered in the correct order.
Punch Position and Hole Punching

The following table illustrates the number of holes and punch positions.

A finisher capable of punching must be installed on the color press.

**Note:** Punch positions vary according to paper size, paper type, number of pages, feed direction, and original orientation.

**Note:** Punch can only occur on the lead or trail edge of the paper. The paper orientation may need be changed in the color press to accommodate all of the punch configurations.

<table>
<thead>
<tr>
<th>Punch setting</th>
<th>Portrait Left</th>
<th>Portrait Right</th>
<th>Portrait Top</th>
<th>Landscape Left</th>
<th>Landscape Right</th>
<th>Landscape Top</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 holes</td>
<td><img src="image1" alt="Illustration" /></td>
<td><img src="image2" alt="Illustration" /></td>
<td><img src="image3" alt="Illustration" /></td>
<td><img src="image4" alt="Illustration" /></td>
<td><img src="image5" alt="Illustration" /></td>
<td><img src="image6" alt="Illustration" /></td>
</tr>
<tr>
<td>3 holes</td>
<td><img src="image7" alt="Illustration" /></td>
<td><img src="image8" alt="Illustration" /></td>
<td><img src="image9" alt="Illustration" /></td>
<td><img src="image10" alt="Illustration" /></td>
<td><img src="image11" alt="Illustration" /></td>
<td><img src="image12" alt="Illustration" /></td>
</tr>
<tr>
<td>4 holes</td>
<td><img src="image13" alt="Illustration" /></td>
<td><img src="image14" alt="Illustration" /></td>
<td><img src="image15" alt="Illustration" /></td>
<td><img src="image16" alt="Illustration" /></td>
<td><img src="image17" alt="Illustration" /></td>
<td><img src="image18" alt="Illustration" /></td>
</tr>
<tr>
<td>Advanced-letter/Advanced-A4</td>
<td><img src="image19" alt="Illustration" /></td>
<td><img src="image20" alt="Illustration" /></td>
<td><img src="image21" alt="Illustration" /></td>
<td><img src="image22" alt="Illustration" /></td>
<td><img src="image23" alt="Illustration" /></td>
<td><img src="image24" alt="Illustration" /></td>
</tr>
</tbody>
</table>

For information about finishers and other installable options, see printer driver Help.
Scale

The operator can specify a scaling override in Command WorkStation, but the override is applied to any scaling value already set in the active job. For example, if a user sends a job with a scaling value of 50% and the operator specifies a Scale override of 300%, the job is printed at 150% of the original document size, that is, 50% of 300%.

Scale to fit

The Scale to fit option allows you to scale a job to a paper size different from the Document size. When you turn on this option, the image is increased or reduced in size to fit the imageable area of the paper size you select from the Paper size menu. The Document size is scaled to the printable imageable area of the paper for edge-to-edge printing. When you turn off this option, the original document size is printed without any scaling, even if you select a larger paper size.

<table>
<thead>
<tr>
<th>Document size</th>
<th>Output paper size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Letter</td>
<td>11x17</td>
</tr>
</tbody>
</table>

Scale to fit turned on

Scale to fit turned off
User Authentication

If Users and Groups user authentication is configured in Fiery server Setup, you must enter a valid user name and password to send a print job to the Fiery server. In Command WorkStation, the management of jobs is determined by how you log on to the Fiery server.

For Mac OS X: Select the Job Info icon and type logon information in the User Name and Password fields.

Use Windows Login: Select this option if you are already logged on to a Windows computer. Otherwise, type your Windows network logon information in the Username and Password fields.

Validate: Click to validate user authorization and to confirm printing privileges. To validate, Two-Way Communication must be turned on. For information on establishing Two-Way Communication, see printer driver Help.

I’m a guest: Select this option to activate guest printing privileges. By default, guest printing is turned on.

For information about enabling Users and Groups user authentication in the Configure WebTool, see Configuration and Setup.
INDEX

INDEX

Numerics
2-color print mapping option 119

A
Account ID field 108
Add pad back cover option 125
Adobe PDF Print Engine option 98
APPE option 98
Apply image enhancement option 123
Auto trapping option 118, 130
automatic rotation 135

B
Back cover paper source option 125
binding method 115
binding options 134
Black detection option 118
Black overprint option 121
Black Text and Graphics option 121
Booklet layout mode 115
Booklet Maker
binding method 115
Booklet back cover option 117
Booklet front cover option 116
Centering Adjustment option 116
Cover Content option 116
Creep compensation 116
Define Cover option 117
Gutter option 116
Increase gutter by option 116
Nested Saddle booklets 131
Page Alignment 116
Paper size 114
Paper size for 2-up 115
settings 133
Shrink to fit option 116
wizard 132, 133, 134
Booklet option 130
Booklet type binding method 115
Brightness option 122

C
Cache PDF and PS objects 127, 129
CMYK mode 118
CMYK/Grayscale Processing method option 119
CMYK/Grayscale Source option 119
Collate option 124, 137
Color mode 118
Color Setup, job overrides 105
Combine separations option 118
Composite overprint option 118
Control Bar option 108
Copies option 107
cover
  inline 135
  pre-printed 135
  selecting media for 136
  settings 134, 135
Cover Content input option 116
Cover page face-down printing option 125
Cover page feed direction option 125
Create master option 126
Creep compensation 116

D
Default Browser connection 68, 72, 76, 79
Default output profile option 121
default print options 35, 61
Define record length 127
Destination option 107
Docs tab in WebTools 31, 57, 82
Document Size option 111, 129
Downloads tab in WebTools 13, 40, 64
Duplex (double-sided) option 113, 115

E
E-mail Service
  about 89
  Manage print jobs 91
Enable enhanced FreeForm option 127
Enable pad printing option 125
Engage fore (face trim) option 125
INDEX 148

F
Fiery Features 85, 87
Fiery Software Uninstaller Utility
deleing 66
installing and using 66
on User Software DVD 9
File name option 107
File port, saving files to 36, 62
File search path 127
Finish size option 125
first-time use 132, 133
Fold option 140
Fold order option 124
Fold style option 124
FreeForm
Print master option 127
FTP Printing 94

G
Gang-up print
Cut & stack 141
Gang-up type 114
Gutter option 115
Increase gutter by option 115
Shrink to fit option 114
Step & repeat 141
Gangup layout mode 114
Gloss level option 122
Gray (CMYK) option 121
Gray (RGB) option 121
Grayscale mode 118
Gutters 115, 116

H
Half tone simulation option 122
Hot Folders job overrides 105

I
I'm a Guest option 107, 129, 145
Image Enhance 142
Apply image enhancement option 123
Image Enhancement Range option 123
Image Quality option 122
Image quality option 122
Image shift option 124
Image smoothing option 122
Imposed layout mode 117
imposition 133
installable options
configuring 29, 55
installing
Job Monitor 30, 56
printer driver from User Software
DVD 15, 41
printer drivers from server 14
printer drivers over the network 65
printer drivers using Point and Print 11, 38
virtual printers using Point and Print 18, 44
Instructions field 107
IP Printer connection 70, 74, 77, 80
IPP connection 27, 53

J
Job copies per pad option 125
Job Monitor
configuring connection 30, 56
installing 30, 56
on User Software DVD 9
using 30, 56
job overrides
print settings 105

L
Layout option see Pages per Sheet
Line Printer Daemon - LPD 70, 74, 77, 80
LPR connection, Windows 23, 49

M
Mac OS X
Default Browser connection 68, 72, 76, 79
deleting printer driver files 66
Fiery Software Uninstaller utility 66
IP Printer connection 70, 74, 77, 80
Line Printer Daemon - LPD 70, 74, 77, 80
printer driver setup 67
printing from applications 82
selecting printers 83
Manage print jobs with e-mail commands 91
managing print jobs 91
measurement unit, specifying 136
Media color option 110
Media type option 110
Media weight option 110
Mirror option 113, 129
Mixed media option 112
N
Nested Saddle booklets 131
Notes option 107

O
Offset jobs option 124
Offset pads option 125
Optimize RGB transparency option 119
Orientation option 113, 129
Orientation override option 113, 129
Output delivery option 124, 142
Output tray option 124
overrides, of job settings 105

P
Pad Printing
  Add pad back cover option 125
  Back cover paper source option 125
  Enable pad printing option 125
  Job copies per pad option 125
  Offset pads option 125
Page Order option 114
Pages per record 127
Pages per Sheet option 114
Paper Catalog option 110
Paper simulation option 120
Paper Size option 138
Paper size option 111
Paper source option 111
Password 107, 129
Password field 108
PDF/x output intent option 120
Perfect booklet setting 131
Point and Print 11, 38
Postflight option 109
PostScript Printer Description file, see PPD
PostScript printer driver
  deleting 21, 47
  download using WebTools 13, 40
  explained 104
  installing from User Software DVD 15, 40
  installing using Point and Print 11, 38
PPD (PostScript Printer Description file) options 105
  Windows 16, 39, 42, 45
Preview Master option 126
Print border option 113
Print dialog box 84
Print master option 127
print options 33, 59, 86, 104
Print queue action option 108, 129
Print Range option 107
printer default settings, where to set 105
Printer Delete Utility 9, 21, 47, 66
printer drivers
  downloading with WebTools 64
  installing 64-bit printer driver 17, 43
  setting up 67
Printer screen mode option 122
Printer’s default 32, 58, 84
printing
  from an application 32, 58
  from Mac OS X applications 82
  to File port 36, 62
  using an E-mail client 89
  with PrintMe 100
  with Web Services for Devices (WSD) 103
printing connections, supported types 22, 48
PrintMe Cloud Printing 100
PrintMe printer driver, installing 101
Prntdrv.exe file 13, 40
Productivity setting option 112
Progressives 109
Proof Print 108
Punch edge option 125, 143
Punch Holes option 143
Punch option 125
Pure Black see Black Text and Graphics

Q
Quick Access, customizing 36, 62, 87

R
reading layout 133
Remove White PPT Background option 127
Resolution option 122
RGB rendering intent option 120
RGB Source option 120
Rich Black see Black Text and Graphics
rotation, automatic 135

S
Sample Print 96
Scale option 113, 144
Scale to fit option 113, 144
Schedule printing option 107
Secure print job, printing and retrieving 95
Secure Print option 129

Secure print option 108
selecting printers
Mac OS X 83
Separate RGB/Lab to CYMK source option 120
sheet 133
Shrink to fit 114, 116
Slip sheet offset option 112
Slip sheet option 112
Slip sheet page size option 112
Slip sheet paper source option 112
SMB printing
completing connection 22, 48
setup 11, 38
speed printing see Gang-up print
Spine pressing option 125
Spot color matching option 120
Standard Booklet setting 131
Stapler mode option 125
Step & repeat 141
subset 134
Subset finishing in use option 124
Substitute colors option 118

T
TCP/IP connection 23, 49
Text sharpness correction option 122
Text/graphics edge enhancement option 123
Text/graphics quality option 122
top binding with a cover 136
Transparency interleave paper source option 112
Transparency interleaving option 112
Tray alignment option 111
Trim value option 125
Two-Way
Communication 20, 32, 36, 46, 58, 62, 84

U
USB flash drive 92
automatic printing of files 92
Use embedded profile when present option 119, 120
Use master option 126
Use maximum printer density option 122
Use media defined profile if available 121
Use Set Page Device Media Mapping
option 110, 129
Use Set Page Device Output Bin Tray Mapping
option 124, 129
User Authentication for Mac OS 145
I’m a Guest option 145
Password option 107, 129, 145
Use Windows Login option 107, 129, 145
User name option 107, 129, 145
Users and Groups user authentication 145
User ID field 108
User Software DVD installing printer driver files 64

V
Variable Data Printing (VDP)
Cache PDF and PS objects 127, 129
Create master option 126
Define record length 127
Pages per record 127
Preview Master option 126
Print master option 127
Use master option 126
virtual printers
installing using Point and Print 18, 44
setting up 18, 44

W
Watermarks option 128
First Page Only setting 128
WebTools
Docs tab 31, 57, 82
Downloads tab 13, 40, 64
Windows
IPP connection 27, 53
LPR or Port 9100 connection 23, 49
printer driver, installing from User Software
DVD 15, 41
TCP/IP connection 23, 49
Windows Server 2003
installing 64-bit printer driver 17, 43
WSD printing 103

Z
Z-Fold 140